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Preface

The purpose of this guide is to help NetBackup™ administrators install the software. The 
NetBackup system administrator is responsible for maintaining backups and disaster 
recovery plans using NetBackup. 

This guide assumes that you have a basic understanding of UNIX system administration, 
experience with the system on which NetBackup is to be installed, and that you have 
properly attached and configured your SCSI devices for the operating system. 

Caution If a device is not properly configured for the operating system, backups made to 
that device result in backup failures and/or data loss. 

Getting Help 
You can find answers to questions and get help from the NetBackup documentation and 
from the VERITAS technical support web site. 

Finding NetBackup Documentation 
A list of the entire NetBackup documentation set appears as an appendix in the NetBackup 
Release Notes. All NetBackup documents are included in PDF format on the NetBackup 
Documentation CD. 

For definitions of NetBackup terms, consult the online glossary. 

▼ To access the NetBackup online glossary 

1. In the NetBackup Administration Console, click Help > Help Topics. 

2. Click the Contents tab. 

3. Click Glossary of NetBackup Terms.


Use the scroll function to navigate through the glossary.
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Getting Help 
Accessing the VERITAS Technical Support Web Site 
The address for the VERITAS Technical Support Web site is http://support.veritas.com. 

The VERITAS Support Web site lets you do any of the following: 

◆	 Obtain updated information about NetBackup, including system requirements, 
supported platforms, and supported peripherals 

◆	 Contact the VERITAS Technical Support staff and post questions to them 

◆	 Get the latest patches, upgrades, and utilities 

◆	 View the NetBackup Frequently Asked Questions (FAQ) page 

◆	 Search the knowledge base for answers to technical support questions 

◆	 Receive automatic notice of product updates 

◆	 Find out about NetBackup training 

◆	 Read current white papers related to NetBackup 

From http://support.veritas.com, you can complete various tasks to obtain specific types 
of support for NetBackup: 

1.	 Subscribe to the VERITAS Email notification service to be informed of software alerts, 
newly published documentation, Beta programs, and other services. 

a.	 From the main http://support.veritas.com page, select a product family and a 
product. 

b.	 Under Support Resources, click Email Notifications. 

Your customer profile ensures you receive the latest VERITAS technical 
information pertaining to your specific interests. 

2.	 Locate the telephone support directory at http://support.veritas.com by clicking the 
Phone Support icon. A page appears that contains VERITAS support numbers from 
around the world. 

Note	 Telephone support for NetBackup is only available with a valid support 
contract. To contact VERITAS for technical support, dial the appropriate phone 
number listed on the Technical Support Guide included in the product box and 
have your product license information ready for quick navigation to the proper 
support group. 

3. Contact technical support using e-mail. 
viii NetBackup Installation Guide for UNIX and Linux 
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Accessibility Features 
a.	 From the main http://support.veritas.com page, click the E-mail Support icon. 

A wizard guides you to do the following: 

◆	 Select a language of your preference 

◆	 Select a product and a platform 

◆	 Provide additional contact and product information, and your message 

◆	 Associate your message with an existing technical support case 

b. After providing the required information, click Send Message. 

Contacting VERITAS Licensing 
For license information, you can contact us as follows: 

◆	 Call 1-800-634-4747 and select option 3 

◆	 Fax questions to 1-650-527-0952 

◆	 In the Americas, send e-mail to amercustomercare@veritas.com. 

In the Asia and Pacific areas, send email to apaccustomercare@veritas.com. 

In all other areas, send email to internationallicense@veritas.com. 

Accessibility Features 
NetBackup contains features that make the user interface easier to use by people who are 
visually impaired and by people who have limited dexterity. Accessibility features 
include: 

◆	 Support for assistive technologies such as screen readers and voice input (Windows 
servers only) 

◆	 Support for keyboard (mouseless) navigation using accelerator keys and mnemonic 
keys 

For details on how NetBackup provides accessibility, refer to the Accessibility Appendix 
in this document. 
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Comment on the Documentation 
Comment on the Documentation 
Let us know what you like and dislike about the documentation. Were you able to find the 
information you needed quickly? Was the information clearly presented? You can report 
errors and omissions or tell us what you would find useful in future versions of our 
manuals and online help. 

Please include the following information with your comment: 

◆ The title and product version of the manual on which you are commenting 

◆ The topic (if relevant) on which you are commenting 

◆ Your comment 

◆ Your name 

Email your comment to NBDocs@veritas.com. 

Please only use this address to comment on product documentation. See “Getting Help” 
in this preface for information on how to contact Technical Support about our software. 

We appreciate your feedback. 
x NetBackup Installation Guide for UNIX and Linux 
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Before You Begin Installing NetBackup 
1 

Installing NetBackup servers and clients is the first step in providing an easy-to-use, 
reliable solution for backing up and restoring data. However, before you start the 
installation, it is important that you take a few minutes to look through your NetBackup 
software package and become familiar with its contents. 

It is important to read the requirements in this chapter, because they list information 
about the installation and the hardware, cluster, and upgrade requirements that are new 
to this release. 

Pre-Installation Software Requirements 
This release of NetBackup contains many changes and enhancements that have caused the 
software to become larger. You can read a brief description of these enhancements in the 
NetBackup Release Notes. 

Depending on the type of platform you are installing, the growth in the software may 
require you to mount more CDs than in earlier releases. 

Note	 To determine how much memory you need before you begin installing NetBackup, 
refer to “NetBackup Server Installation Requirements” on page 5. To view the 
different binary sizes, refer to “NetBackup Binary Sizes” in the NetBackup Release 
Notes. 

NetBackup License Key Requirements 
When installing a NetBackup master or media server, you must enter a NetBackup base 
product license key. Check your release package to make sure that you have license keys 
for all the NetBackup servers, clients, options, and agents that you requested. 

Enter all product license keys on the master server when prompted during the 

installation. 
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Pre-Installation Software Requirements 
For more information about license keys, refer to “NetBackup License Keys” on page 75. 
For detailed information on how to administer NetBackup license keys, refer to the both 
volumes of the NetBackup System Administrator’s Guide, Volume 1. 

NetBackup Supportability 

Note	 The “Supported Platforms and Operating Systems” table in the NetBackup Release 
Notes provides a Client Selection column that identifies which clients to install with 
which operating systems. 

NetBackup supports mixed versions between master and media servers, enabling you to 
upgrade NetBackup one server at a time, which minimizes impact on overall system 
performance. 

Caution VERITAS supports upgrading NetBackup 5.0MP4 or later servers to NetBackup 
6.0. However, VERITAS does not support a server upgrade directly from 
NetBackup 4.5 GA, FPx, or MPx to NetBackup 6.0. If you currently have 
NetBackup 4.5 installed on a server that you want to upgrade, you must 
perform an intermediate upgrade to NetBackup 5.x and then upgrade to 
NetBackup 6.0. 

The following table shows all of the server and client configurations for which VERITAS 
provides support. VERITAS supports only these combinations of servers and clients. 

Master Server Version Media Server Version Client Version 

NetBackup 6.0 6.0 6.0 

NetBackup 6.0 6.0 5.0MP4 (or later) or 5.1 

NetBackup 6.0 5.0MP4 (or later) or 5.1  5.0MP4 (or later) or 5.1 

Servers are able to pull and push their version information between master and media 
servers. The version of NetBackup on your server determines whether the version 
information can be pushed. 

◆	 A media server that is upgraded to NetBackup 6.0 uses the vmd service to push its 
version information to all servers in its master server list after start-up is initiated. In 
addition, every 24 hours an automatic update occurs when servers with this revision 
push their version information out to the servers again. 
2 NetBackup Installation Guide for UNIX and Linux 



Pre-Installation Software Requirements 
◆	 Servers running a version of NetBackup that is earlier than NetBackup 5.0MP4 are not 
supported in a NetBackup 6.0 environment. If a query times out for a particular 
server, it is classified as a “pre-5.x” version of NetBackup. 

Caution	 Before you upgrade the NetBackup software on a NetBackup master server or 
Enterprise Media Manager (EMM) server, you must back up your NetBackup 
catalogs and verify that the catalog backup was successful. 

Understanding the Contents of Your NetBackup Media Kit 
Your VERITAS NetBackup media kit includes multiple CDs. The contents of each CD is 
shown on the CD label. 

The following table lists the title of each CD, along with a brief description of its contents. 

NetBackup Software CD Contents 

VERITAS CD Contents 

Documentation CD The documentation CD is provided with each 
product order and provides documentation for all 
VERITAS NetBackup Software products included in 
this release. The documentation on this CD is in PDF 
format and organized into product groups. You can 
print selected PDF files using Acrobat Reader. 

If you insert the documentation CD in a Microsoft 
Windows system CD drive with Autorun enabled, 
you see a web page listing the documents that you 
can select to view. If Autorun is not enabled, navigate 
to the CD drive to view the CD contents. 

To use the documentation CD on a UNIX- or 
Linux-based system, mount the CD according to the 
instructions in “Mounting the Software CD” on 
page 13 and either view the documents from the CD 
or copy the documents from the CD to a local drive 
for future reference. 

Windows Server CDs 

Windows 32-bit Server Contains the Windows 32-bit server and all Windows 
clients and databases/add-ons for a Windows 32-bit 
operating system. 
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NetBackup Software CD Contents  (continued) 

VERITAS CD	 Contents 

Windows IA64-bit Server	 Contains the Windows 64-bit server and all Windows 
clients and databases/add-ons for a Windows IA 
64-bit operating system. 

UNIX Server CDs 

IBM AIX and HP Tru64 CD	 ◆ AIX 5.1 RS/6000, AIX 5.2, or AIX 5.3 server types 

◆	 Alpha Tru64 5.1b and 5.1b2 server types and 
ALPHA: OSF1_V5 client types 

HP CD	 ◆ HP9000 - PA-RISC: HP-UX 11.0, 11.11 and 11.23 

◆ HP - Integrity: HP-UX 11.23 

Linux CD ◆ Intel 32-bit Linux: Red Hat 2.4 client types 

◆ IA64 Linux: SuSE 2.4 client types 

Sun Solaris Solaris 8, 9, and 10 server types and corresponding 
Solaris: Solaris 8, 9, and 10 client types. 

UNIX Clients CD Contains all UNIX clients 

UNIX Options CD Contains all Database agents, Advanced Client, BMR, 
BMR boot, Encryption, NDMP and Vault 

NetBackup Storage Migrator CD Contains NetBackup Storage Migrator 

Common-Component CDs 

Infrastructure Core Services (ICS) for AIX VxSS Security and PBX Installer for AIX 

ICS for HP900 PA-RISC VxSS Security and PBX Installer for HP-UX 

ICS for HP Integrity VxSS Security and PBX Installer for HP IA-64 

ICS for Intel 32-bit Linux VxSS Security and PBX Installer for Linux 

ICS for IA64 Linux VxSS Security and PBX Installer for Linux IA-64 

ICS for Solaris VxSS Security and PBX Installer for Solaris 
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NetBackup Server Installation Requirements 
NetBackup Software CD Contents  (continued) 

VERITAS CD Contents 

ICS for Tru64 VxSS Security and PBX Installer for HP Tru64/Alpha 

ICS for Windows 32 VxSS Security and PBX Installer for Windows 

ICS for Windows IA64 VxSS Security and PBX Installer for Windows IA-64 

NetBackup Server Installation Requirements 
◆	 VERITAS recommends that you remove any other vendor backup software currently 

configured on your system before installing this product. Other vendor backup 
software can negatively affect how NetBackup installs and functions. 

◆	 Ensure that you have a server of a supported hardware type running a supported 
version of its operating system (with applicable patches), adequate disk space, and 
supported peripherals. For details on these requirements, refer to the NetBackup 
Release Notes. 

◆	 For reasonable performance of the NetBackup-Java interfaces, you need 512 MB of 
RAM, of which 256 MB are available to the interface program (jnbSA or jbpSA). 

◆	 Ensure that you have all NetBackup CDs. 

◆	 Ensure that you have the minimum screen resolution configuration is 1024x768, 256 
colors. 

◆	 Ensure that you have the root password for the server and appropriate license keys. 

◆	 Ensure that the gzip and gunzip commands are installed on the local system, and 
that the directories where the commands are installed are part of the root user’s PATH 
environment variable setting. 

◆	 Ensure that all NetBackup servers recognize and are recognized by their client 
systems. In some environments, this means that each must be defined in the other’s 
/etc/hosts file. Other environments may use the Network Information Service 
(NIS) or Domain Name Service (DNS). 

◆	 Identify the devices you plan to use in your NetBackup configuration. See the 
NetBackup Release Notes for a list of the robot types supported. 

◆	 For some peripherals and platforms, kernel reconfiguration is required. For more 
details, see the Media Manager Device Configuration Guide. 

◆	 For Red Hat Linux: 


NetBackup requires server networking.
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◆	 For Solaris systems: 

There are several kernel-tunable parameters, such as Message Queue, Semaphore, 
and Shared Memory Parameters, that can affect NetBackup performance. Adjusting 
these values may prevent your system performance from slowing down or even 
reaching a deadlock state.For additional information such as parameter definitions 
and examples, refer to the NetBackup Tuning Guide for UNIX on the VERITAS Support 
Web site by entering this tuning guide title in the Search field. 

◆	 Message Queue parameters: It can be necessary to increase the system’s message 
queue resources to avoid having NetBackup daemons hang. 

For example, you may need to make the following changes to the /etc/system 
file: 

set msgsys:msginfo_msgmap=512

set msgsys:msginfo_msgmax=8192

set msgsys:msginfo_msgmnb=65536

set msgsys:msginfo_msgmni=256 

set msgsys:msginfo_msgssz=16

set msgsys:msginfo_msgtql=512 

set msgsys:msginfo_msgseg=8192 


Reboot the system. 

◆	 Semaphore parameters: On UNIX systems, errors may occur on systems that do 
not have enough semaphores allocated. System requirements vary; thus, no 
absolute recommendations can be made. However, the following changes to the 
/etc/system file should be sufficient for an average system: 

set semsys:seminfo_semmap=64

set semsys:seminfo_semmni=1024

set semsys:seminfo_semmns=1024

set semsys:seminfo_semmnu=1024

set semsys:seminfo_semmsl=300

set semsys:seminfo_semopm=32

set semsys:seminfo_semume=64


You must reboot the system. 
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◆	 To avoid potential shared memory problems, the default buffer size for disk 
backups has been increased to 256K with this release. If you are performing 
multiple copies of disk and tape, the default buffer size should, at a minimum, 
equal the tape buffer size. 

If you encounter a system could not allocate enough shared memory 
error, you should refer to your vendor documentation for instructions on how to 
increase the amount of shared memory on your system. For Solaris platforms, you 
can make the following changes to the /etc/system file to obtain a sufficient 
amount of memory. 

set shmsys:shminfo_shmmax=16777216

set shmsys:shminfo_shmmin=1

set shmsys:shminfo_shmmni=220

set shmsys:shminfo_shmseg=100


Note that shminfo_shmmin must be less than or equal to 100.


After making these changes, you must reboot using the boot -r command. 


◆	 For clustered environments: 

◆	 Make sure that each node in the cluster where you install NetBackup can run the 
rsh command or its equivalent (on HP-UX, the command is remsh). As the root 
user you need to be able to perform a remote login to each node in the cluster 
without entering a password. This is only necessary for installation and 
configuration of the NetBackup server and any NetBackup agents and options. 
Once installation and configuration is complete, this is no longer required. 

◆	 You must have the cluster frameworks installed, configured, and started before 
installing NetBackup. Refer to the NetBackup High Availability System 
Administrator’s Guide for additional installation prerequisites and installation 
notes. 

◆	 You must have a virtual name defined using DNS, NIS, or /etc/hosts. The IP 
address is defined at the same time. (The virtual name is a label for the IP 
address.) 

◆	 For access-controlled environments: 

◆	 You must install the VERITAS Security Software (VxSS) either before or after you 
install or upgrade NetBackup on your server. The order does not matter, however 
it is important that you install this software before you use NetBackup, to benefit 
from an access controlled environment. 

◆	 The Authorization broker must reside on the master server. 
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Installation Notes 

◆	 NetBackup Enterprise only: If you are not adding any NetBackup media servers, ignore 
all references to them. 

◆	 Allow about 30 minutes to install the server software. Additional time is required to 
configure the product for your environment. 

◆	 On the NetBackup server, the installation directory contains the software and the 
NetBackup catalog, and these can become quite large. 

If space is an issue, consider installing NetBackup on an alternate file system. The 
installation allows you to select an alternate install location, and creates the 
appropriate link from /usr/openv. 

◆	 Because the product uses file locking, VERITAS recommends that you not install 
NetBackup in an NFS mounted directory. File locking in NFS mounted file systems 
can be unreliable. 

◆	 For HP-UX systems: 

◆	 Install NetBackup on a file system that supports long file names. 

◆	 An error may occur while creating the NetBackup database during the 
installation process. This error, shown below, can be corrected by increasing the 
number of semaphores in the HP-UX kernel. For a detailed explanation on how to 
change HP-UX kernel parameters, refer to TechNote number 243461 on the 
VERITAS support web site. 

SQL error (-832) -- Connection error: Insufficient system 

resources - failed to allocate a SYSV semaphore
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NetBackup Server Upgrade Requirements 
◆	 NetBackup 6.0 contains features that are dependent on a new Infrastructure Core 
Services (ICS) product called VERITAS Private Branch Exchange (PBX). 

PBX helps limit the number of TCP/IP ports used by many new features in 
NetBackup. In addition, it allows all socket communication to take place while 
connecting through a single port. The PBX port number is 1556. For more information 
about PBX and configuring NetBackup ports, refer to the both volumes of the 
NetBackup System Administrator’s Guide, Volume 1. 

Because PBX is required for all NetBackup products, its installation is part of the 
NetBackup installation procedure unless it is already present on the system. When 
you begin installing NetBackup on a server, the installation procedure determines if a 
version of PBX is already installed. Whether PBX is installed causes one of the 
following to happen: 

◆	 If a version of PBX already exists, the installation procedure uses that version of 
PBX and continues. 

◆	 If PBX does not exist, you see message similar to the following: 

The following package(s) are missing and must be installed 

before NetBackup can be installed:


VRTSpbx


The missing package(s) are located on the VERITAS Infrastructure Core Services 
(ICS) CD, which is included in the NetBackup media kit. You need to do the 
following: 

a.	 From a different window, unmount/eject the NetBackup Server software 
installation CD. 

b.	 Mount the CD that contains the PBX software. Refer to the table “NetBackup 
Software CD Contents” on page 3 for an exact name of this CD. 

c.	 From the original window where you began installing NetBackup, enter the 
CD pathname (the directory where the installics script is located). 

d.	 The NetBackup installation script attempts to install PBX automatically. 

NetBackup Server Upgrade Requirements 
With the many new features included in NetBackup 6.0, some new upgrade requirements 
have been put in place to make your transition to this version of NetBackup easier. 
Chapter 1, Before You Begin Installing NetBackup 9 



NetBackup Server Upgrade Requirements 
◆	 VERITAS only supports server upgrades from NetBackup 5.0MP4 (or later) or 5.1 to 
this version of NetBackup. NetBackup does not support an upgrade from any 
pre-NetBackup 5.0MP4 version to NetBackup 6.0. If you currently have a 
pre-NetBackup 5.0MP4 version installed, you must perform an intermediate upgrade 
to NetBackup 5.x first, and then you can upgrade to NetBackup 6.0. 

◆	 After you install the NetBackup server software as a part of an upgrade installation, 
you must run the command nbpushdata. This command moves data from your 
current database files (a subset of the NetBackup catalog) into a newly created EMM 
database. 

This final step in the upgrade process is critical to ensure that your NetBackup 
environment is functional. 

The sequence of when and where you run the nbpushdata command is extremely 
important. With earlier releases, VERITAS has always suggested that you upgrade your 
master servers first, followed by the media servers, the volume database host server(s), 
and finally the clients. However, this is not the recommended order for running 
nbpushdata and populating the EMM database. For more detail on running 
nbpushdata and creating the EMM database when you upgrade, refer to “Populating 
the NetBackup EMM Database” on page 55. 

The following list provides the order in which you must run the nbpushdata command 
in your environment. (You only need to run nbpushdata -add once on a particular 
host.) 

1.	 5.x Global Device Database Host - You must run nbpushdata -add on the 5.x server 
that was configured as the Global Device Database Host. This is usually a master 
server, but a media server as the Global Device Database Host is also a supported 
configuration. 

2.	 Master servers - There is no particular order in which you must run 
nbpushdata -add on your master servers after you have run it on the server that 
was configured as the Global Device Database Host. 

3.	 Volume Database Hosts - You must next run nbpushdata -add on the server 
designated as a Volume Database Host. If the Volume Database Host was also the 
Global Device Database Host, this step does not apply. 
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NetBackup Server Upgrade Requirements 
4.	 Media Servers - Any remaining media servers that have been upgraded to 
NetBackup 6.0. Media servers can be upgraded at a later time. 

If you are leaving any media servers at NetBackup 5.x, you must log in to the master 
server(s) administering those backlevel media servers and run 
nbpushdata -modify_5x_hosts. See “To configure 5.x media servers for 
compatibility with 6.0 environments” on page 60 for detailed instructions. 

After you have upgraded to NetBackup 6.0 and run the nbpushdata command, once, 
you do not need to run it again because all of the appropriate data has been moved into 
the new EMM database. 

The following list shows the version 5.x database files that are moved to the EMM 
database. 

◆	 volmgr/database/globDB 

◆	 volmgr/database/ltidevs 

◆	 volmgr/database/robotic_def 

◆	 volmgr/database/.namespace.chksum (NDMP) 

◆	 volmgr/database/ruleDB 

◆	 volmgr/database/poolDB 

◆	 volmgr/database/volDB 

◆	 netbackup/db/media/mediaDB 

◆	 netbackup/db/config/storage_units 

◆	 netbackup/db/config/stunit_groups 

◆	 volmgr/vm.conf entries 

◆	 DISALLOW_NONNDMP_ON_NDMP_DRIVE 

◆	 DO_NOT_EJECT_STANDALONE 

◆	 DRIVE_NAME_SEED 

◆	 RETURN_UNASSIGNED_MEDIA_TO_SCRATCH_POOL 

◆	 SCRATCH_POOL 

◆	 SSO_SCAN_ABILITY 

◆	 VAULT_CLEAR_MEDIA_DESC 
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NetBackup Server Upgrade Requirements 
◆	 netbackup/bp.conf on UNIX or the corresponding Windows registry entries 

◆	 ALLOW_MULTIPLE_RETENTIONS_PER_MEDIA 

◆	 DISABLE_STANDALONE_DRIVE_EXTENSIONS 

◆	 MEDIA_ID_PREFIX 

◆	 MEDIA_REQUEST_DELAY 

◆	 MUST_USE_LOCAL_DRIVE 

◆	 Touch files 

◆	 netbackup/DONT_USE_SLAVE 

◆	 netbackup/DRIVE_ERROR_THRESHOLD 

◆	 netbackup/MEDIA_ERROR_THRESHOLD 

◆	 netbackup/TIME_WINDOW 

◆	 volmgr/NO_STANDALONE_UNLOAD 

◆	 If you are concerned that your current installation of NetBackup is corrupt, contact 
VERITAS Technical Support for assistance. 

◆	 You can upgrade to this version of NetBackup only if the NetBackup software that 
you currently have installed is NetBackup 5.0MP4 or later. 

Note VERITAS supports upgrading NetBackup 5.0MP4 or later servers to NetBackup 
6.0. However, VERITAS does not support an upgrade directly from NetBackup 
4.5 GA, FPx, or MPx to NetBackup 6.0. If you currently have NetBackup 4.5 
installed on a server that you want to upgrade, you must perform an 
intermediate upgrade to NetBackup 5.x and then upgrade to NetBackup 6.0. 

◆	 Changing a master server into a media server is not an allowable upgrade. It is 
considered a downgrade.  To make this change, you must first uninstall the earlier 
version of NetBackup and perform a new installation. 

◆	 Make certain that the NetBackup release level on the server is at least equal to that on 
the clients. Older versions of server software can encounter problems with newer 
clients. 

◆	 Add-ons must be at the same level as the NetBackup client or server on which the 
add-on is installed. 

◆	 NetBackup Enterprise only: NetBackup does not support converting an existing 
non-failover server to a highly available failover NetBackup server. 
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Installing NetBackup 
2 

NetBackup includes wizards that make installing and configuring the software easy. 

Installing and configuring NetBackup involves the following steps: 

1. Mounting the Software CD 

2. Installing NetBackup Server Software 

3. Installing Alternative Administration Interfaces 

4. Installing NetBackup Agents and Options (optional) 

Note After you have finished the installation, you can perform basic configuration steps 
as described in “Initial NetBackup Configuration” on page 101. 

Mounting the Software CD 
Use the following directions as a guideline for mounting NetBackup CDs. You may need 
to use other flags or mounting options, which you can determine by working with your 
hardware vendor. 

In the examples in this section, the options and arguments specify the following: 

A -v, -t, or -F option specifies the type of file system to mount. 

A -o option on systems other than IRIX translates files names properly, if required. 
On IRIX systems, a -o ro option specifies that you want to mount the CD as

read-only.


A -r option specifies that you want to mount the CD for reading.


The device_path specifies the name of the CD drive.


The mount_point specifies the directory where you want to mount the CD.
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Mounting the Software CD 
AIX 

1.	 Log in as root. 

2.	 Mount the CD using either of the following methods: 

◆	 Using smitty: 

smitty cdrfs


OR 

smitty mountfs


◆	 Manually: 

◆	 Create the mount point (for example, mkdir /cdrom). 

◆	 Run the mount command, as follows: 

mount -v cdrfs -r device_path mount_point 

For example, the following command mounts the CD manually using 
/cdrom as the mount point and /dev/cd0 as the device path: 

mount -v cdrfs -r /dev/cd0 /cdrom 


Alpha Tru64 

1.	 Log in as root. 

2.	 Create the mount point (for example, mkdir /cdrom). 

3.	 Mount the CD, as follows: 

mount -r -t cdfs -o noversion device_path mount_point


For example, the following command mounts the CD using /cdrom as the mount 
point and /dev/disk/cdrom0a as the device path: 

mount -r -t cdfs -o noversion /dev/disk/cdrom0a /cdrom


FreeBSD 

1.	 Log in as root. 

2.	 Create the mount point (for example, mkdir /cdrom). 
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Mounting the Software CD 
3. Mount the CD, as follows: 

mount -r -t cd9660 device_path mount_point


For example, the following command mounts the CD using /cdrom as the mount 
point and /dev/acd0c as the device path: 

mount -r -t cd9660 /dev/acd0c /cdrom 

HP-UX 
Mounting and unmounting the CD on HP-UX differs depending on the version of the 
operating system you are running. 

▼ To mount the CD on HP-UX 11.23 or later operating systems 

1. Log in as root. 

2. Mount the CD, as follows: 

mount -F cdfs device_path mount_point


▼ To unmount the CD on HP-UX 11.23 or later operating systems 

3. Unmount the CD, as follows: 

umount mount_point


4. Remove the CD from the drive. 

▼ To mount the CD on HP-UX operating systems earlier than 11.23 

1. Log in as root. 

2. Create the mount point (for example, mkdir /cdrom). 

3. Start the PFS daemons, as follows: 

nohup pfs_mountd & 

nohup pfsd & 
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4. Mount the CD, as follows: 

pfs_mount -o xlat=unix device_path mount_point


To find the device path, you can run ioscan -fn. 

For example, the following command mounts the CD using /cdrom as the mount 
point and /dev/rdsk/c3t2d0 as the device path: 

pfs_mount -o xlat=unix /dev/rdsk/c3t2d0 /cdrom 

▼ To unmount the CD on HP-UX operating systems earlier than 11.23 

1. Unmount the CD, as follows: 

pfs_umount mount_point


For example, the following command unmounts a CD that used /cdrom as the mount 
point: 

pfs_umount /cdrom


2. Stop the following processes using the kill command: 

pfs_mountd

pfsd

pfs_mountd.rpc

pfsd.rpc


IRIX 

1. Log in as root. 

2. You can use the mediad command to auto-mount the CD. 

3. If mediad does not work, perform the following steps: 

a. Create the mount point (for example, mkdir /cdrom). 

b. Mount the CD, as follows: 

mount -o ro -t iso9660 device_path mount_point


You can determine the device_path by running a hardware inventory using the 
hinv command. 

For example, the following command mounts the CD using /cdrom as the mount 
point and /dev/rdsk/dks0d6vol as the device path: 

mount -o ro -t iso9660 /dev/rdsk/dks0d6vol /cdrom 
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Linux 

1.	 Log in as root. 

2.	 Create the mount point (for example, mkdir /cdrom). 

3.	 Mount the CD, as follows: 

mount device_path mount_point


For example, the following command mounts the CD using /cdrom as the mount 
point and /dev/cdrom as the device path: 

mount /dev/cdrom /cdrom


Installing NetBackup Server Software 
Before running the NetBackup installation script, first review “What Does the Installation 
Script Do?” below and “NetBackup Server Installation Requirements” on page 5. If you 
are performing an upgrade, refer to “Performing an Upgrade Installation” on page 33. 

Caution	 Before installing NetBackup, make sure you have the most current operating 
system patches and updates applied to your system. If you are not certain of 
your operating system level, contact your vendor and request the latest patches 
and upgrades. 

What Does the Installation Script Do? 
In addition to installing NetBackup on the server, the installation script does the 

following:


◆	 Places the name of the host in the /usr/openv/netbackup/bp.conf file on the 
server. 

For clustered environments: 

The script places the virtual host name in the /usr/openv/netbackup/bp.conf 
file on the server. 

◆	 Adds entries to the /etc/services file for NetBackup and Media Manager services 
(for example, robotic daemons). The /etc/services file contains UNIX system 
information. 

◆	 Checks to see if your server is running Network Information System (NIS). NIS is the 
UNIX directory service utility. If it is running, you are instructed to add entries to 
your NIS services map. 
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Installing NetBackup Server Software 
◆ Adds automatic startup and shutdown scripts to the appropriate directories on the 
various supported platforms. 

Note These scripts are removed in clustered environments. 

◆ Adds entries to the following server file or directory to facilitate networking: 

/etc/inetd.conf file 

OR 

/etc/xinetd.d directory 

Entries are added for bpcd, vnetd, vopied, and bpjava-msvc. After they are 
added, the script signals inetd (or xinetd), causing it to read the updated file. 

Note	 Before you install or use NetBackup on a Linux (Red Hat/SuSE) client, verify 
that the inetd (or xinetd) service is started on that machine. This ensures 
proper communication between the NetBackup master server and the Linux 
client. 

Note For Solaris 10: The inetd.conf entries are also converted into smf service 
manifests and imported into the smf repository via the inetconv command. 

◆ For Solaris systems: 

The installation procedure prompts you for the name of an alternate root path. An 
alternate boot environment lets you install NetBackup on a different server. 

For example, suppose that Host B’s root, usr, and var file systems are mounted on 
Host A as /alt, /alt/usr, and/alt/var. You can, when logged in to Host A, 
specify /alt as the alternate root environment and install NetBackup on Host B. This 
feature applies to NetBackup server only, and not add-ons, clients, or database agents. 

Installing NetBackup Server 

Note	 After installing a NetBackup master or media server, you must enter a NetBackup 
product license key. On the master server, you must also enter license keys for any 
additional NetBackup product options or agents used on the server or its clients. 
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▼	 To install NetBackup server software 

1.	 Ensure that you have license keys for all the NetBackup servers, number of clients, 
options, and agents that you ordered. 

For more information on administering NetBackup licenses, see the NetBackup System 
Administration Guide, Volume I. 

Note	 After making and saving any license key updates (including adding and deleting 
license keys) in the NetBackup-Java Administration Console, you must restart the 
console. 

Note Installing the EMM Server on a media server is a supported configuration, although 
it is not recommended. See for steps to follow for such a configuration. 

2.	 Log in to the server as root. 

3.	 Insert the appropriate NetBackup CD in the drive and mount it, if necessary. 

Note	 For instructions on mounting the CD on your operating system, refer to the 
appropriate section of “Mounting the Software CD” on page 13. For 
information on CD contents and exact names, refer to the table “NetBackup 
Software CD Contents” on page 3. 

4.	 Run the installation script, which installs both Media Manager and NetBackup server 
software: 

cd_directory/install


The cd_directory is the path to the directory where you can access the CD. 

Note For media servers: The EMM server must be running when you install media 
servers. 

Note For clustered environments: During the installation, enter the virtual name for the 
NetBackup server and not the actual local host name. 

5.	 The following step applies only if you do not have VERITAS Private Branch Exchange (PBX) 
currently installed on your system. 

NetBackup 6.0 contains features that are dependent on a new Infrastructure Core 
Services (ICS) product called VERITAS Private Branch Exchange (PBX). 
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PBX helps limit the number of TCP/IP ports used by many new features in 
NetBackup. In addition, it allows all socket communication to take place while 
connecting through a single port. The PBX port number is 1556. For more information 
about PBX and configuring NetBackup ports, refer to the NetBackup System 
Administration Guide, Volume I. 

Note	 For clustered environments: PBX has a known issue that prevents it from being 
installed in the cluster using the push installation method you can usually 
employ with installics. To install PBX in a cluster, you must run the 
installics command on every node. 

Because PBX is required for all NetBackup products, its installation is part of the 
NetBackup installation procedure unless it is already present on the system. When 
you begin installing NetBackup on a server, the NetBackup installation procedure 
determines if a version of PBX is already installed. Whether PBX is currently installed 
causes one of the following to happen: 

◆	 If a version of PBX already exists, the installation procedure uses that version of 
PBX and continues. 

◆	 If PBX does not exist, you see a message similar to the following: 

The following package(s) are missing and must be installed 

before NetBackup can be installed:


VRTSpbx


The missing package(s) are located on the VERITAS Infrastructure Core Services 
(ICS) CD, which is included in the NetBackup media kit. 

a.	 In a different window, unmount/eject the NetBackup Server software 
installation CD. 

b.	 Mount the CD that contains the PBX software. 

c.	 From the original window where you began installing NetBackup, enter the 
CD pathname (the directory where the installics script is located). 

d.	 The NetBackup install script attempts to install PBX automatically. 

6.	 Follow the prompts in the installation script. 

During the installation, the correct NetBackup client software is automatically 
installed on the server. To install additional client software on your current server, 
continue with Steps 7a and 7b. 
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7.	 Complete this step only if you want to install clients. 

a.	 Mount the client CD.


A menu appears that displays the available client types. 


b.	 Select the client type that you want to install and follow the prompts to install that 
client type. 

Note	 For each UNIX client type, the installation script enables you to load the client 
software onto the server. You can then “push” this client software from the 
server to the clients. 

(Make sure you load the software for all the UNIX client types you intend to 
back up onto the server. Otherwise, you cannot add these client types to the 
NetBackup policy configuration.) 

c.	 Repeat step 7b as necessary until all your client types have been installed. 

d.	 Unmount the client CD. 

8.	 For clustered environments: 

a.	 Repeat this installation process on every node that you want run NetBackup. (For 
a TruCluster cluster, you only have to perform the installation once because 
/usr/openv is shared.) 

b.	 Run /usr/openv/netbackup/bin/cluster/cluster_config on the 
active node. 

Caution	 When prompted by the cluster_config script, you must provide the same 
virtual cluster name that you provided during the installation. This name is also 
case-sensitive. If applicable, provide the fully qualified name. For example, if 
you indicate the name “clusternbu.domain.com” during installation, but 
“clusternbu” or “CLUSTERNBU.DOMAIN.COM” for the cluster_config 
script, the configuration process will fail. 

Installing Access Control 
To use access control, you must also install the VERITAS Security Services (VxSS) 
component onto your NetBackup system. 
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▼ To install access control 

Note For initial installations, install access control after you have successfully installed 
NetBackup. 

1.	 Install the VERITAS Security Services components on your system. 

The VxSS components reside on an ICS CD. The following table contains the 
minimum installation requirements as they apply to each NetBackup system where 
you have successfully installed NetBackup. 

NetBackup System Required VERITAS Security Services (VxSS) Components 

NetBackup master server	 Authentication client and server components 

Authorization client and server components 

NetBackup media server	 Authentication client components 

Authorization client components 

NetBackup client	 Authentication client components 

NetBackup Remote Authentication client components 
Administration Console Authorization client components 

Note	 If you want to perform cross-platform authentication with Windows platforms, 
you must install an authentication broker on a Windows system. For 
instructions on how to install an authentication broker, refer to the VERITAS 
Security Services Administrator’s Guide. 

2.	 After you have finished installing NetBackup and the VxSS components, you can 
configure the access control features. For detailed information on how to configure 
access control, refer to the NetBackup System Administration Guide, Volume II. 

Configuring the Window Manager for Java Interface 
(NetBackup-Java Compatible Platforms) 

Always set your window manager so windows become active only when you click inside 
the windows. Do not enable auto focus (in which windows become active if you move the 
mouse pointer over them). The NetBackup-Java interfaces do not run properly with auto 
focus enabled. 
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CDE (Common Desktop Environment) 

The CDE (Common Desktop Environment) window manager is the preferred window 
manager for NetBackup-Java applications. 

▼	 To set up a CDE window manager 

1.	 On the front panel in the CDE window, click the Style Manager control icon. 

The Style Manager toolbar appears. 

2.	 On the Style Manager toolbar, click the Window control icon.


The Style Manager - Window dialog box appears.


3.	 In the Style Manager - Window dialog box, choose Click In Window To Make Active. 

Click OK. 

4.	 When you see the Restart the Workspace Manager prompt, click OK. 

Installing Alternative Administration Interfaces 
You can install a NetBackup user interface on a different computer. (This is necessary if 
your server computer has no graphics display capabilities.) 

System Install this user interface 

Windows NetBackup Remote Administration Console or 

NetBackup-Java Administration Console for Windows 

UNIX NetBackup-Java Administration Console 

Multiple versions of the NetBackup-Java Administration Console 

NetBackup Remote Administration Console for Windows 
You can skip this section if you do not want to administer a NetBackup server remotely 
from a Windows NetBackup client. 

The NetBackup Remote Administration Console is a version of NetBackup for Windows 
that can be used to remotely administer one or more UNIX or Windows NetBackup 
servers. It provides all of the standard NetBackup Server for Windows interfaces and can 
be used on a remote server to create backup policies, manage volumes, view status, 
monitor tape drives, and so on. It cannot be used as a NetBackup master or media server 
itself—only for the remote administration of other NetBackup UNIX or Windows servers. 
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Note	 The NetBackup Remote Administration Console is supported on Windows 2000, 
Windows XP, and Windows 2003 server. For information about the supported 
platforms for this NetBackup release, refer to the Supported Platforms and 
Peripherals chapter in the NetBackup Release Notes. 

Although the NetBackup Remote Administration Console cannot be used as a master or 
media server, in order for it to remotely administer a NetBackup server, it must be added 
to the server list on that server in the same way that other NetBackup servers are added to 
the server list to give them access to that server. 

The NetBackup manuals and online help do not, in most cases, specifically refer to the 
NetBackup Remote Administration Console because, for all practical purposes, using the 
NetBackup Server for Windows interfaces on the NetBackup Remote Administration 
Console is identical to using them locally on the server that is being administered. The 
server shown in the interface is the name of the server that is being administered rather 
than a local host name. 

▼	 To install the NetBackup Remote Administration Console 

1.	 On the computer on which you want to install the NetBackup Remote Administration 
Console, insert the CD that contains the NetBackup server software for Windows. 

◆	 On Windows systems with Autorun enabled, the installation browser starts 
automatically. 

◆	 On Windows systems that have Autorun disabled, navigate to the CD drive and 
run Launch.exe. 

2.	 On the initial screen, click NetBackup Installation. 

3.	 On the installation screen, click Install Server Software. 

4.	 On the Welcome screen, click Next. 

5.	 On the License Agreement screen, accept the terms of the license agreement and click 
Next. 

6.	 On the Installation Type screen, select Install to this computer only and Typical. 

Click Next. 

7.	 On the NetBackup License Key and Server Type screen, select NetBackup Remote 
Administration Console. You do not need a license key to install the Remote 
Administration Console. 
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8.	 On the NetBackup System Names screen, provide the name of the master server you 
want to administer and any other servers that you may want to administer (such as 
media servers). 

Note	 The name of the NetBackup Remote Administration Console should be in the first 
entry field. In the Master Server field, enter the name of the remote NetBackup you 
want to administer. 

9.	 On the Ready to Install the Program Screen, click Install. 

10. After the installation completes, you can either add license keys (click Add Keys) or 
click Finish. 

If you left the box checked next to Launch NetBackup Administration Console now, 
the Remote Administration Console appears. If you removed the check, start the 
console by choosing Start > Programs > VERITAS NetBackup > NetBackup 
Administration Console. 

▼	 To add the NetBackup Remote Administration Console host to the server list of the 
remote server 

Note	 On a UNIX system, there are two procedures that you can use to add the host to the 
server list: you can use the NetBackup Administration Console for UNIX (if your 
system is Java-compatible) or you can edit the bp.conf file. Step 1 describes this 
process using the NetBackup Administration Console for UNIX and Step 2 
describes how to edit the bp.conf file. 

1.	 Use the NetBackup Administration Console for UNIX to specify and add the remote 
server to the server list. 

a.	 In the left pane of the NetBackup Administration Console for UNIX, select Host 
Properties > Master Servers. The host server appears in the main window. 

b.	 Right-click the name of the host server in the master servers window in the right 
pane. 

c.	 Select Properties. The Master Server Properties window appears. 

d.	 In the Master Server Properties window, select the Servers icon from the tree in 
the left window pane. 

e.	 In the Servers window, click Add. 
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f.	 Type the name of the host that is to run the NetBackup Remote Administration 
Console. 

Click Add. The name of the host appears in the Additional Servers list. 

Click Close and OK.


If you perform this step, you can proceed to step 3.


2.	 For editing the bp.conf file only: 

a.	 Log in to the UNIX master server as root. 

b.	 Edit /usr/openv/netbackup/bp.conf. 


At the end of the SERVER = lines, add the following line:


SERVER = Remote-Administration-Console-machine-name


The Remote-Administration-Console-machine-name is the name of the machine 
where the NetBackup Remote Administration Console resides. 

3.	 If you have an existing NetBackup Remote Administration Console installed and you 
want to add a remote master server to administer, perform the following steps. 

a.	 On the remote NetBackup Windows Server, start the NetBackup Remote

Administration Console.


Note For new installations, you can add the masters that you want to administer as 
additional servers during the installation. 

b.	 In the left pane of the NetBackup Remote Administration Console, select Host 
Properties > Master Server. The host server appears in the main window. 

c.	 Right-click the name of the host server in the master servers window in the right 
pane. 

d.	 Select Properties (Read/Write). The Master Server Properties window appears. 

e.	 In the Master Server Properties window, click the Servers tab. 

f.	 In the Global Operations box, in the field labeled Add to all lists, type the name 
of the host that is to run the NetBackup Remote Administration Console. Then 
click the “+” button. (The name of the host appears in the Additional Servers list.) 

Click OK. 
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NetBackup-Java Administration Console 
The NetBackup-Java Administration Console can be used to administer one or more 
UNIX or Windows NetBackup servers. It provides all of the standard NetBackup Server 
interfaces, and it can be used on a remote NetBackup server to create backup policies, 
manage volumes, view status, monitor tape drives, and so on. 

On Java-capable hosts (servers and clients), the administration console is installed when 
you install NetBackup on the host. For remote administration of any NetBackup server, 
specify the server name in the Login dialog. 

Installing or Removing Multiple Versions of the 
NetBackup-Java Administration Console on Windows 

A NetBackup environment may contain servers of various NetBackup versions. There are 
a number of methods to administer servers in a mixed-version environment. 

One method is to install a relevant version of the NetBackup-Java Administration Console 
on a Windows desktop, then use that installation to administer all servers of the same 
version. 

Installation Considerations 

There are two things to keep in mind when installing multiple versions of the 

NetBackup-Java Administration Console in a mixed environment. 


During installation: 

◆	 Provide a unique string for the host name when asked (pre-6.0 versions). 

◆	 Install each Java console version to a different folder. 

▼	 To install earlier versions of the NetBackup-Java Administration Console 

1.	 The NetBackup-Java Administration Console for the Windows platform is not 
installed automatically. 

Insert the NetBackup Windows installation CD containing the version of the 
NetBackup-Java Administration Console you want to install. 

2.	 If you are installing NetBackup 5.0, select NetBackup Installation and click Install 
Java Administration Console. 

If you are installing NetBackup 5.1, select NetBackup Installation and click Java 
Windows Display Console. Select whether you would like to install the 32-bit or 
64-bit console. 
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3.	 If a different version of the Java console has already been installed, specify a different 
folder location. This prevents overwriting the earlier installation (for example, specify 
C:\Program Files\VERITAS\nbjava50). 

4.	 The wizard asks you to enter the name of the host you want to manage. For ease of 
use, instead of entering a host name, enter a name that reflects the version of the 
console being installed (for example, 5.0GA). 

After the installation, the host name you enter appears in the following locations: 

◆	 As the default host name in the login screen of the NetBackup-Java 
Administration Console dialog. 

The descriptive host name displays here only the first time the console is opened. 
After you change the name to an actual host name in the login dialog, log in to the 
console, and then exit the console normally, that actual host name becomes the 
default and appears the next time the console is started. 

◆	 On the VERITAS NetBackup menu (Start > Programs > VERITAS NetBackup > 
NetBackup-Java on host_name). 

◆	 As a desktop shortcut icon. 

Notes 

◆	 Before installing mixed versions of the NetBackup Administration Console, consider 
that only the most recently installed version can be patched. 

◆	 Only the most recently installed version can be removed using the standard Windows 
Add/Remove Programs utility. See the following section for information on 
uninstalling versions installed prior to the most recently installed version.) 

◆	 The NetBackup-Java Capabilities Authorization configuration file, auth.conf, must 
always be located in install_path\java (for example, in 
C:\Program Files\Veritas\java). The file must exist there regardless of how 
many versions of the console are installed or in which directories they are installed. 

The file is only relevant for administering NetBackup on this Windows host, and there 
are defaults if the file is not present. The defaults are discussed in the NetBackup 
System Administrator’s Guide, Volume I in the section on authorizing NetBackup-Java 
users. 

▼	 To uninstall earlier versions of the NetBackup-Java Administration Console 

1.	 Remove the folder where the NetBackup-Java Administration Console was installed. 

2.	 Remove the appropriate menu item from the Start > Programs > VERITAS 

NetBackup menu.

28 NetBackup Installation Guide for UNIX and Linux 



Installing Alternative Administration Interfaces 
3. Remove any relevant desktop shortcuts. 

Administering Backlevel NetBackup Servers 
There are five general methods to accomplish backlevel administration tasks in 
NetBackup 6.0. The methods are listed below, though the ordering does not imply any 
preference. 

Earlier Versions of the NetBackup-Java Administration Console on Supported UNIX 
Platforms 

Use the earlier versions of the NetBackup-Java Administration Console installed on the 
supported UNIX GUI platforms. The earlier versions available in a release are all of those 
supported in a mixed version environment with the current release, (all those back to and 
including the last major release version). In the 6.0 release, the 5.0MP4 (or later) and 5.1 
versions of the console are available. 

Earlier Versions of the NetBackup-Java Administration Console on Windows Platforms 

Use the earlier versions of the NetBackup-Java Administration Console installed on the 
supported Windows platforms. For details on how to install multiple versions of the 
NetBackup-Java console, see “Installing or Removing Multiple Versions of the 
NetBackup-Java Administration Console on Windows” on page 27. 

Remote Display-back from UNIX Servers 

Use the UNIX remote display-back capabilities for UNIX servers that can run 

NetBackup-Java, possibly in conjunction with tools such as Exceed or VNC.


Remote Display-back from Windows Servers 

Use the NetBackup Administration Console for Windows with the remote display-back 
capabilities on Windows NetBackup servers with tools like Windows Terminal Services or 
Remote Desktop. 

At the Console of the Backlevel Server 

Use the relevant NetBackup-Java Administration Console from the backlevel server’s 
console. 
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Java Windows Administration Console 
The Java Windows Administration Console lets you run the NetBackup Java (UNIX) 
interfaces on supported Windows platforms. This interface provides the same capabilities 
as the NetBackup Administration Console for Windows or UNIX. 

You can skip this section if you do not want to remotely administer your UNIX 
NetBackup servers using the Java Windows Administration Console on a Windows 
platform. 

Note You can install the Java Windows Administration Console from the NetBackup CD 
for Windows. 

Note	 If you are using NetBackup Access Control, the VxSS At client component must be 
installed on the Windows host before installing the Java Windows Administration 
Console. This ensures that the Windows Display Console uses the VxSS component 
correctly. 

Installation Requirements 

For the computer on which you want to run the Java Windows Administration Console, 
VERITAS recommends 512 MB of physical memory. 

▼	 To install the NetBackup-Java Windows Display Console 

1.	 On the system where you are performing the installation, insert the CD that contains 
NetBackup server software for Windows. 

◆	 On Windows systems with Autorun enabled, the installation starts automatically. 

◆	 On Windows systems that to not have Autorun disabled, navigate to the CD 
directory and run Launch.exe. 

2.	 On the initial screen, select NetBackup Installation. 

3.	 On the installation screen, select Install Java Windows Administration Console. 

4.	 On the Welcome screen, click Next. 

5.	 On the License Agreement screen, accept the agreement and click Next. 

6.	 On the NetBackup Installation Type screen, select Install to this computer only and 
Typical. 

7.	 On the Ready to Install the Program screen, click Install. 
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8.	 On the System Validation Complete screen, click Finish. 

9.	 You can open the NetBackup-Java Windows Display Console by choosing Start > 
Programs > VERITAS NetBackup > NetBackup Java version 6.0. 

Installing NetBackup Agents and Options 
After your initial installation is complete, you can install any other NetBackup agents and 
options (such as NetBackup for Oracle) by following the instructions in the 
administrator’s guide that comes with that product. 
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3 

This chapter explains how to upgrade UNIX servers (which includes populating the EMM 
database) and clients to NetBackup 6.0. 

Requirements 
You should ensure that the NetBackup release level on each server is at least equal to that 
on the clients. Older versions of server software can encounter problems with newer 
clients. 

Caution Back up your NetBackup databases before upgrading NetBackup software on 
the master server. 

You can upgrade to this version of NetBackup only if you have installed NetBackup 
5.0MP4 (or later) or 5.1. If you have an earlier version installed (for example NetBackup 
4.5), you cannot upgrade directly to NetBackup 6.0. You must first upgrade to NetBackup 
5.x and then upgrade. 

Note	 If you have NetBackup 5.0 and earlier clients that are unsupported for NetBackup 
6.0, and you encounter problems with using the new features of 6.0, move those 
earlier clients to a separate policy. 

◆	 Review the “NetBackup Server Installation Requirements” on page 5 before 
upgrading NetBackup. Many of these requirements apply to upgrading NetBackup. 

◆	 It is critical that you populate the Enterprise Media Manager Database after you have 
upgraded your master servers. See “Examples of Populating the NetBackup EMM 
Database” on page 36 for an overview of the new database and the procedure for 
populating it. 

◆	 Ensure that the gzip and gunzip commands are installed on the local system, and 
that the directories where the commands are installed are part of the root user’s PATH 
environment variable setting. 
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◆	 NetBackup Operations Manager (NOM) considerations. 

NOM is a new product based on a new architecture. It is not an incremental update to 
any existing VERITAS products. This means that current NetBackup Global Data 
Manager (GDM) and NetBackup Advanced Reporter (NBAR) installations cannot be 
upgraded to NOM installations in NetBackup 6.0. There are substantial differences 
and enhancements in the architecture, design, implementation, data model, and 
historical data from GDM or NBAR in previous versions of NetBackup. 

Note	 If you have any pre-NetBackup 6.0 releases installed on your server that have 
NBAR or GDM, you must uninstall GDM and NBAR from your server 
completely before you upgrade to NetBackup 6.0. 

◆	 For Solaris systems: 

The installation procedure prompts you for the name of an alternate root path. An 
alternate boot environment lets you install NetBackup on a different server. 

For example, if Host B’s root, usr, and var file systems are mounted on Host A as 
/alt, /alt/usr, and /alt/var, you can, when logged in to Host A, specify /alt as 
the alternate root environment and install NetBackup on Host B. This feature applies 
to NetBackup only, and not add-ons or database agents. 

◆	 For clustered environments: 

Note Refer to the NetBackup High Availability System Administrator’s Guide for 
installation prerequisites and notes. 

◆	 Before you upgrade, you must have the cluster frameworks installed, configured, 
and started. 

◆	 Cluster environments are only supported with NetBackup Enterprise Server. 

◆	 The name you enter during the upgrade for the NetBackup server is the virtual 
server name, not the actual local host name. 

◆	 Make sure that each node in the cluster where you install NetBackup can run the 
rsh command or its equivalent (on HP-UX, the command is remsh). As the root 
user you need to be able to perform a remote login to each node in the cluster 
without entering a password. This is only necessary for installation and 
configuration of the NetBackup server and any NetBackup agents and options. 
Once installation and configuration is complete, this is no longer required. 

◆	 The virtual server name must be defined using DNS, NIS, or /etc/hosts. The IP 
address is defined at the same time. (The virtual name is a label for the IP 
address.) 
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◆	 The CLUSTER_NAME must be exactly the same in each bp.conf configuration 
file. This is required to properly store the device configuration information for 
each cluster node in the EMM database. If this is not the case, the upgrade may 
not detect all of the nodes in the cluster. 

Upgrading NetBackup on UNIX Servers and Clients 
After you insert the appropriate NetBackup CD into your computer, the installation 
process begins searching to determine if an earlier NetBackup version exists on your 
system. The presence of an existing version of NetBackup dictates that you are about to 
perform an upgrade. 

The procedures in this section describe how to upgrade NetBackup from previous 
versions, or from NetBackup Server to NetBackup Enterprise Server. It also describes how 
this version can handle media servers with different versions of NetBackup running. 

Note	 For this release of NetBackup, you must complete two procedures to ensure that you 
have properly upgraded NetBackup. 

You must first upgrade your NetBackup software by performing the same upgrade 
procedures as you have with previous versions of NetBackup. 

Secondly, you must run a new nbpushdata command to gather previous 
NetBackup data and populate the new NetBackup EMM database on your server. 

When installing or upgrading the NetBackup software, VERITAS has recommended the 
following order: 

1.	 Master server 

2.	 Media server 

3.	 NetBackup Remote Administration Consoles 

4.	 NetBackup clients 

5.	 Any NetBackup add-on products 

This order is valid in reference to clean installations and when installing the NetBackup 
server software as part of an upgrade. However, the order in which you run nbpushdata 
and populate the EMM database is not the same and is quite crucial. See “Examples of 
Populating the NetBackup EMM Database” on page 36 for an overview of the database 
and procedures for populating it. 
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Caution	 NetBackup processes must be running on the master server and its associated 
media servers before you upgrade and run the nbpushdata -add command. 
This is true no matter where you are running the command. 

The EMM database creation process establishes that it can communicate with 
any additional servers in your configuration, and it does not include servers in 
the database if it cannot establish a connection and determine that NetBackup 
processes are running on the server. 

However, you must ensure that no NetBackup policies are active, no jobs are 
running, and that media servers do attempt to connect to the master server until after 
all upgrades are complete and nbpushdata has been run on all servers. You 
can use the NetBackup Administration Console to deactive all policies and all 
media servers. Command-line equivalents are also available. 

Allowing for Reinstallation of Earlier Versions of NetBackup 
If you ever intend to reinstall a previous version of NetBackup after you have performed 
an upgrade, backups are essential. If you need to reinstall, these backups contain your 
most recent data. 

Note For clustered environments: The reinstallation of an earlier version of NetBackup is 
not supported. 

▼	 To allow for reinstalling earlier versions of NetBackup 

1.	 Back up all databases (media, volume, configuration, device) and catalogs on the 
master and remote media servers. 

2.	 Back up all NetBackup patches, scripts, and bp.conf entries that are specific to the 
earlier version of NetBackup. 

3.	 You do not have to upgrade your clients at this time, only the master and remote 
media servers. 

Examples of Populating the NetBackup EMM Database 
The nbpushdata command enables NetBackup to get copies of the existing database files 
(a subset of the NetBackup catalogs) from each host and places this data in a new EMM 
database. 
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Data is copied to the EMM database only when nbpushdata is run on a server that has 
been upgraded to NetBackup 6.0. No data is moved to the EMM database from any other 
server except the server where nbpushdata is being run. It is because of these 
requirements that an upgrade of NetBackup is not complete until you have successfully 
updated the EMM database. 

This section contains various scenarios of NetBackup configurations. These scenarios are 
only guidelines on how to upgrade NetBackup and run nbpushdata in a NetBackup 
environment. Choose the scenario that closely resembles your configuration, and use it as 
a guide when you perform the actual procedure outlined in “Upgrading NetBackup 
Servers” on page 49. 

Note	 You use nbpushdata to upgrade an existing supported NetBackup 5.x 
environment that contains a single Global Device Database host. It is not a tool for 
merging multiple NetBackup environments. 

Scenario 1: Global Device Database Host and Volume Database Host 
on One Master Server 

In many environments, a master server also is designated as the NetBackup 5.0MP4 (or 
later) or 5.1 Global Device Database Host and the Volume Database Host. 

If this is true for you, upgrade your NetBackup software on all of your master servers 
first, making sure that you do not run the nbpushdata -add command on any of these 
servers until you complete the upgrade of all the master servers. 

After the upgrade of the master servers is complete and nbpushdata is run on those 
servers, you can upgrade your media servers as you like. You can upgrade some of your 
media servers to NetBackup 6.0 and leave some at version 5.x. 
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Your environment would look something like the following diagram. 

Global Device Database Host Master Servers 
Volume Database Host 
Master Server 

Media Servers being 
upgraded to 6.0 

Media Servers staying 
at 5.x 

In such an environment, your first step is to upgrade all master servers from 5.0MP4 (or 
later) or 5.1 to 6.0. Do not upgrade the media servers in your environment at this time. 

Step 1: 
Upgrade master 
servers only 

Global Device Database Host Master servers 
Volume Database Host 
Master Server 

Media Servers 
upgraded to 6.0 staying at 5.x 

Media Servers being 
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The next step is to ensure that the NetBackup and Media Manager daemons are running 
on the master server that is also the Global Device Database Host and the Volume 
Database Host. Then you run nbpushdata -add. 

Step 2:

Run nbpushdata on

this server first


Global Device Database Host

Volume Database Host

Master server Master servers 

Next you ensure that the NetBackup and Media Manager daemons are running on all the 
other master servers. Then run nbpushdata -add on each server. 

Step 3: 
Run nbpushdata on all 
other master servers 

EMM server and 

EMM database Master Servers

Master server


At this point, you can optionally upgrade media servers to NetBackup 6.0. You are not 
required to upgrade media servers. NetBackup version 5.x media servers run with 
NetBackup 6.0. 
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If you want to upgrade a 5.x media server to NetBackup 6.0, you must first install 
NetBackup 6.0 server software on the 5.x media server. Next, ensure that the Media 
Manager daemons are running on the media server, and then run the nbpushdata -add 
command on the media server. 

EMM server and 

EMM database Master Servers

Master server


Step 4:

Upgrade media servers; 

run nbpushdata -add on

media servers after

upgrading them


For any media server that you wish to leave at the 5.x version level, log in to the master 
server(s) for the media server(s) that are staying at version 5.x and run 
nbpushdata -modify_5x_hosts. 

Media Servers 
staying at 5.x 

Master server 

EMM server and 
EMM database 

Media servers 

Step 5: 
Run nbpushdata -modify_5.x_hosts only on 
master servers that manage media servers 
staying at version 5.x 

Upgraded media 
servers 

Master servers 
managing 5.x 
media servers 

staying at 5.x 
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Scenario 2: Global Device Database Host and Volume Database Host 
on Different Master Servers 

In some environments, a master server is designated as the NetBackup 5.0MP4 (or later) 
or 5.1 Global Device Database Host and a different master server is the Volume Database 
Host. 

If this is true for you, upgrade your NetBackup software on all of your master servers 
first, making sure that you do not run the nbpushdata -add command on any of these 
servers until you complete the upgrade of all the master servers. 

After the upgrade of the master servers is complete, you are ready to run the 
nbpushdata -add command on the master server that was designated as the 5.x Global 
Device Database Host. After successfully running nbpushdata on this server, you can 
run nbpushdata on the remaining master servers, then on the master server that is 
designated as the Volume Database Host server, followed by the media servers. 

Your environment would look something like the following diagram. 

Global Device Database Host 
Master Server Master Servers Volume Database Host 

Master Server 

Media Servers being 
upgraded to 6.0 

Media Servers staying 
at 5.x 
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In this environment, the first step is to upgrade all master servers to NetBackup 6.0. Do 
not upgrade the media servers in your environment at this time. 

Step 1: 
Upgrade master 
servers only 

Global Device 
Database Host Master Servers Volume Database Host 
Master Server Master Server 

Media Servers Media Servers being 
upgraded to 6.0 staying at 5.x 

The next step is to ensure that the NetBackup and Media Manager daemons are running 
on the master server that is also the Global Device Database Host. Then run 
nbpushdata -add on that host. 

Step 2:

Run nbpushdata on

this server first


EMM server and 
EMM database Master Servers Volume Database Host 
Master server Master Server 
42 NetBackup Installation Guide for UNIX and Linux 



Upgrading NetBackup on UNIX Servers and Clients 
Next, you should ensure that the NetBackup and Media Manager daemons are running 
on each master server. Then run nbpushdata -add on each master server except for the 
master server that is designated as the Volume Database Host. 

Step 3:

Run nbpushdata on

other master servers,

but NOT the Volume 

Database Host


EMM server and 

EMM database 
 Master Servers 

Volume Database HostMaster server 
Master Server 

Next, ensure that the NetBackup and Media Manager daemons are running on the master 
server that is designated as the Volume Database Host. Then run nbpushdata -add on 
that server. 

Step 4: 
Run nbpushdata 
on the Volume 
Database Host 

EMM server and 

EMM database 
 Volume Database Host 
Master server Master Servers Master Server 

At this point, you can optionally upgrade media servers to NetBackup 6.0. You are not 
required to upgrade media servers. NetBackup version 5.x media servers run with 
NetBackup 6.0. 
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If you want to upgrade a 5.x media server to NetBackup 6.0, you must first upgrade the 
media server to NetBackup 6.0. Next, ensure that the Media Manager daemons are 
running on the media server, and then run the nbpushdata -add command on the 
media server 

Volume Database Host 
Master Server 

EMM server and 
EMM database 
Master server Master Servers 

Step 5: 
Upgrade media servers; 
run nbpushdata -add on 
media servers after 
upgrading them 

Media Servers 
staying at 5.x 

For any media server that you wish to leave at the 5.0MP4 (or later) or 5.1 version level, 
log in to the master server(s) for the media server(s) staying at version 5.x and run 
nbpushdata -modify_5x_hosts. 

EMM server and 
Master servers EMM database 

Media servers 
staying at 5.x 

Step 6: 
Run nbpushdata -modify_5.x_hosts only on 
master servers that manage media servers 
staying at version 5.x 

managing 5.xMaster server 
media servers 

Upgraded media

servers
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Scenario 3: Global Device Database Host Is on a Media Server 

In some environments, a media server is designated as the NetBackup 5.0MP4 (or later) or 
5.1 Global Device Database Host and a different master server is the Volume Database 
Host. 

If this is true for you, the order in which you upgrade NetBackup and then run the 
nbpushdata command becomes more complicated. 

First upgrade NetBackup on all of your master servers, making sure that you do not run 
the nbpushdata -add command on any of these servers. 

After the upgrade of the master servers is complete, upgrade the media server that is the 
Global Device Database Host. Next, you run the nbpushdata -add command on that 
media server. After successfully running nbpushdata -add on that media server, run it 
on the remaining master servers, making sure that you run this command last on the 
master server that is designated as the Volume Database Host. 

After you have populated the EMM database with the server information from the Global 
Device Database Host, the master servers, and the Volume Database Host, you can 
upgrade your remaining media servers as you like. You might upgrade some of your 
media servers to NetBackup 6.0 and leave some at version 5.x. 

Your environment would look something like the following diagram. 

Master Servers Volume Database Host 

upgraded to 6.0 
Media Servers staying 

at 5.x 

Media Servers being 

Master Server 

Global Device 
Database Host 
Media Server 
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In this environment, the first step is to upgrade all master servers from 5.x to 6.0. The 
order in which you upgrade master servers is not significant. Do not upgrade any of the 
media servers, or run nbpushdata on any servers in your environment at this time. 

Step 1: 
Upgrade master 
servers only 

Master Servers 

Volume 
Database 
Host 
Master Server 

Global Device 

Database Host
 Media Servers staying 
Media Server Media Servers being at 5.x 

upgraded to 6.0 

The next step is to upgrade the 5.x media server that was designated as the Global Device 
Database Host to NetBackup 6.0. You should not upgrade any of the other media servers in 
your environment at this time. 

Volume 
Database 
Host 
Master Server 

Master Servers 

Step 2: 
Upgrade the 
media server 
that was the 
Global Device 
Database Media Servers 
Host Global Device staying at 5.x 

Database Host Media Servers being


Media Server upgraded to 6.0
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Next, ensure that the NetBackup and Media Manager daemons are running on the media 
server that is also the Global Device Database Host. Then run nbpushdata -add. You 
should not run the command on any of the master servers yet. 

Volume 
Database 
Host 
Master Server 

Master Servers 

Step 3:

Run nbpushdata on

the media server

that was the Global 

Device Database

Host


Database Host Media Servers being 
Media Server upgraded to 6.0 

Next you must ensure that the NetBackup and Media Manager daemons are running on 
each master server. Then run nbpushdata -add on each master server except for the 
master server that is designated as the Volume Database Host. 

Step 4: Volume 
Run nbpushdata Database 
on master Host 
servers, but NOT Master Server 
on the Volume 
Database Host 

Master Servers 

Media Servers 
staying at 5.x 

Global Device 

Media Servers 
staying at 5.xGlobal Device 

Database Host Media Servers being 

Media Server upgraded to 6.0 
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Next you must ensure that the NetBackup and Media Manager daemons are running on 
the master server that is designated as the Volume Database Host, and then run the 
nbpushdata -add command. 

Step 5: Volume 
Run nbpushdata Database 
on the Volume Host 
Database Host Master Server 

Master Servers 

If you have media servers to upgrade, you do that next. You are not required to upgrade 
media servers. NetBackup version 5.x media servers run with NetBackup 6.0. 

If you want to upgrade media servers to NetBackup 6.0, you must first upgrade 
NetBackup on the media servers. 

Ensure that the Media Manager daemons are running on the media server. Run the 
nbpushdata -add command on the media server. 

Step 6: 
Upgrade media servers; 
run nbpushdata -add on 
the media servers after 
upgrading them 

Media Servers 
staying at 5.x 

Volume 
Database 
Host 

Master Servers 

Master Server 

EMM server and 
EMM database 
Media Server 
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Finally, for any media server that you wish to leave at the 5.0MP4 (or later) or 5.1 version 
level, log in to the master server(s) for the media server(s) staying at version 5.x and run 
nbpushdata -modify_5x_hosts. 

Media Servers 
staying at 5.x 

Volume 
Database 
Host 

Master 
Servers 

Master Server 

Step 7: 
Run nbpushdata -modify_5.x_hosts 
only on master servers that 
administer media servers staying at 
version 5.0 or 5.1 

Master servers 
administering 5.x 
media servers 

Upgraded media 

EMM server and 
EMM database 
Media Server 

servers 

Upgrading NetBackup Servers 

Note	 Upgrades are not supported from releases of NetBackup earlier than NetBackup 
5.0MP4 (or later) or 5.1. You must upgrade earlier releases to NetBackup 5.0 MP4 or 
5.1 and then upgrade to NetBackup 6.0. 

Caution	 For clustered environments: If you are upgrading a clustered environment to 
NetBackup 6.0, refer to the NetBackup High Availability System Administrator’s 
Guide for installation prerequisites and notes specific to your cluster 
environment. 

Note For clustered environments: Converting an existing non-failover NetBackup server to 
a highly available failover NetBackup server is not supported. 
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Upgrading NetBackup Server Software 

This section contains instructions on how to upgrade NetBackup. The following section 
describes how to populate the EMM database using the nbpushdata command. The 
order in which you run nbpushdata to populate the EMM database is crucial. For your 
convenience and understanding, examples of various NetBackup configurations and the 
order in which nbpushdata must be run are provided in “Examples of Populating the 
NetBackup EMM Database” on page 36. 

Caution	 NetBackup processes must be running on the master server and its associated 
media servers before you upgrade and run the nbpushdata -add command. 
This is true no matter where you are running the command. 

The EMM database creation process establishes that it can communicate with 
any additional servers in your configuration, and it does not include servers in 
the database if it cannot establish a connection and determine that NetBackup 
processes are running on the server. 

However, you must ensure that no NetBackup policies are active, no jobs are 
running, and that media servers do attempt to connect to the master server until after 
all upgrades are complete and nbpushdata has been run on all servers. You 
can use the NetBackup Administration Console to deactivate all policies and all 
media servers. Command-line equivalents are also available. 

Note	 For instructions on mounting the CD on your operating system, refer to the 
appropriate section of “Mounting the Software CD” on page 13. For information on 
CD contents and exact names, refer to the table “NetBackup Software CD Contents” 
on page 3. 

Note	 If you have made changes to configuration files in /usr/openv/java/, the 
changes are not preserved in the upgrade. You need to make the changes again. The 
backups of the configuration files (called nbj.conf.bak and auth.conf.bak) 
are created in /usr/openv/java/ during the upgrade, and you can reference 
them to make the changes again. 

1.	 The following step applies to those users who want to install and use NetBackup Access 
Control (NBAC). 

a.	 Shut down all NetBackup services. 

b.	 Mount the ICS CD that corresponds to your system. It contains the VERITAS 
Security Services components (VxSS and PBX). 
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c.	 From the ICS CD, install PBX on your system. 

d.	 Install the VERITAS Security Services components, which are located on the same 
ICS CD as PBX. 

The following table contains the minimum installation requirements as they apply to 
each NetBackup system. 

NetBackup System Required VxSS Components 

NetBackup master server Authentication client and server components 

Authorization client and server components 

NetBackup media server Authentication client components 

Authorization client components 

NetBackup client Authentication client components 

NetBackup Remote 
Administration Console 

Authentication client components 

Authorization client components 

Note	 If you want to perform cross-platform authentication with Windows platforms, 
you must install an authentication broker on a Windows system. For 
instructions on how to install an authentication broker, refer to the VERITAS 
Security Services Administrator’s Guide. 

2.	 Deactivate all Policies: 

For NetBackup Administration Console users: 

a.	 Open the NetBackup Administration Console on the master server 

b.	 Select Polices from the tree on the left. 

c.	 Select all of the policies that appear in the right pane. 

d.	 Right-click the polices and select Deactivate. 

For command-line users: 

e.	 Enter the following command: 

/usr/openv/netbackup/bin/admincmd/bpplinfo policy_name -modify -inactive
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3.	 Deactivate all media servers: 

For NetBackup Administration Console users: 

a.	 Open the NetBackup Administration Console on the master server 

b.	 Select Media and Device Management > Devices > Hosts from the tree on the 
left. 

c.	 Select all of the media servers that appear in the right pane. 

d.	 Right-click the media servers and select Deactivate. 

For command-line users: 

e.	 Enter the following command: 

/usr/openv/volmgr/bin/vmoprcmd -deactivate_host -h device_host


4.	 For Solaris systems: 

Caution	 All of the NetBackup scripts that you may have modified are removed when 
you complete step 4b. You may want to save any files that you have modified 
and want to keep, before you perform this step. 

a.	 If it exists, remove the following file: 

rm -f /usr/openv/netbackup/bin/driver/snapctl10_x


b.	 Whether you are upgrading or reinstalling NetBackup, remove the current 
NetBackup server package. 

pkgrm VRTSnetbp


c.	 You see the following prompt: 

Are you doing this pkgrm as a step in an upgrade process?


Answer y (yes). 

5.	 For AIX systems: 

Caution	 This step deletes any robotic control paths. For more information about the 
robotic control paths, see the NetBackup Media Manager Device Configuration 
Guide. 

Uninstall the ovpass driver, as follows: 

/usr/openv/volmgr/bin/driver/remove_ovpass 
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Note In an AIX clustered environment, you must run this step on all nodes in the 
cluster. 

6. Ensure that you have license keys for all the NetBackup servers, clients, options, and 
agents that you ordered. 

Note NetBackup Enterprise only: When installing a master or media server, you must 
enter a NetBackup Enterprise server license key. 

For more information on administering NetBackup licenses, see the NetBackup System 
Administration Guide, Volume I. 

7. Log on as the root user on the server. 

8. Insert the appropriate NetBackup Server CD in the drive. 

Note 

9. Run the installation script, as follows: 

cd_directory/install


The cd_directory is the path to the directory where you can access the CD. On some 
platforms, it may be necessary to mount the directory. 

10. This step applies only if you do not have VERITAS Private Branch Exchange (PBX) currently 
installed on your system. 

NetBackup 6.0 contains features that are dependent on a new Infrastructure Core 
Services (ICS) product called VERITAS Private Branch Exchange (PBX). 

PBX helps limit the number of TCP/IP ports used by many new features in 
NetBackup. In addition, it allows all socket communication to take place while 
connecting through a single port. The PBX port number is 1556. For more information 
about PBX and configuring NetBackup ports, refer to the NetBackup System 
Administration Guide, Volume I. 

Note	 For clustered environments: PBX has a known issue that prevents it from being 
installed in the cluster using the push installation method you can usually 
employ with installics. To install PBX in a cluster, you must run the 
installics command on every node. 
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Because PBX is required for all NetBackup products, its installation is part of the 
NetBackup installation procedure unless it is already present on the system. When 
you begin installing NetBackup on a server, the NetBackup installation procedure 
determines if a version of PBX is already installed. Whether PBX is currently installed 
causes one of the following to happen: 

◆	 If a version of PBX already exists, the installation procedure uses that version of 
PBX and continues. 

◆	 If PBX does not exist, you see a message similar to the following: 

The following package(s) are missing and must be installed

before NetBackup can be installed:


VRTSpbx


The missing package(s) are located on the VERITAS Infrastructure Core Services 
(ICS) CD, which is included in the NetBackup media kit. 

To install PBX at this point in the upgrade process, do the following: 

a.	 In a different window, unmount/eject the NetBackup Server software 
installation CD. 

b.	 Mount the CD that contains the PBX software. 

c.	 From the original window in which you began installing NetBackup, enter 
the CD path name (the directory where the installics script is located). 

The NetBackup installation script attempts to install PBX automatically. 

11. Follow the prompts in the installation script to install the NetBackup server binaries. 
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Note During the upgrade, you see the following prompt: 

Do you want to start the NetBackup bprd process so backups and 

restores can be initiated? [y , n] (y)


Accepting the default (typing y or pressing Return) means that backups and 
restores can be initiated after the upgrade is complete. It also means that, if you 
have any active policies from the previous version of NetBackup, it is possible 
that the new version of NetBackup could use one of those policies and start a 
backup or restore operation while you are trying to configure NetBackup. 

It is best to schedule your upgrade and reconfiguration for a time that you 
know does not conflict with backups running, or perhaps to temporarily 
modify policies so that no jobs are running while you are reconfiguring. 

If you type n in response, the daemons are not started, and you must start bprd 
and ltid before you can run NetBackup. 

12. Optional step to upgrade clients: 

During the upgrade, the correct NetBackup client software is automatically installed 
on the server. To install additional client software on your current server, you can 
mount the client CD and run that installation script. 

The client CD installation script enables you to load the client software on the server 
for each of the UNIX client types that NetBackup supports. You can then “push” this 
client software from the server to your UNIX clients. For information on how to 
upgrade clients, refer to “Upgrading Clients After Servers Are Upgraded” on page 61. 

13. For clustered environments only. 

Unfreeze the NetBackup group. 

14. After you have finished upgrading NetBackup and the VxSS components applicable 
to the type of NetBackup system you are installing, you can configure the access 
control features. For detailed information on how to configure Access Control, refer to 
the NetBackup System Administration Guide, Volume II. 

Populating the NetBackup EMM Database 
Your upgrade of NetBackup is not complete until you have successfully populated the 
EMM database. 
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Note Use nbpushdata to upgrade an existing supported NetBackup 5.0MP4 (or later) or 
5.1 environment that contains a single Global Device Database host. It is not a tool 
for merging multiple NetBackup environments. 

The nbpushdata command enables NetBackup to get copies of the existing database files 
(a subset of the NetBackup catalogs) from each host and places this data in the EMM 
database. 

Starting with NetBackup 6.0, the terms “Global Device Database Host” and “Volume 
Database Host” are obsolete. The EMM server takes over the function of the Global Device 
Database Host and the EMM database takes over the function of the Volume Database 
Host. 

Caution It is imperative that you follow the prescribed sequence when running the 
nbpushdata command in your NetBackup environment. 

Run the nbpushdata command on the following servers in the following order: 

1. 5.0MP4 (or later) or 5.1 Global Device Database Host 

2. Master servers 

3. Volume Database Hosts 

4. Any remaining media servers that have been upgraded to NetBackup 6.0 

The Global Device Database Host, master server(s), and the Volume Database Host must 
be upgraded to NetBackup 6.0 and have nbpushdata run on them before the NetBackup 
environment is functional. 

Media servers are not required to be upgraded at the same time as the other servers. They 
can be upgraded at a later time. 
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Caution	 NetBackup processes must be running on the master server and its associated 
media servers before you upgrade and run the nbpushdata -add command. 
This is true no matter where you are running the command. 

The EMM database creation process establishes that it can communicate with 
any additional servers in your configuration, and it does not include servers in 
the database if it cannot establish a connection and determine that NetBackup 
processes are running on the server. 

However, you must ensure that no NetBackup policies are active, no jobs are 
running, and that media servers do attempt to connect to the master server until after 
all upgrades are complete and nbpushdata has been run on all servers. You 
can use the NetBackup Administration Console to deactivate all policies and all 
media servers. Command-line equivalents are also available. 

▼ To populate the EMM database on upgraded servers 

Caution Do not perform this procedure if you have not already upgraded the master 
servers in your NetBackup 6.0 environment. 

1.	 Deactivate all Policies. 

For NetBackup Administration Console users 

a.	 Open the NetBackup Administration Console on the master server 

b.	 Select Polices from the tree on the left. 

c.	 Select all of the policies that appear in the right pane. 

d.	 Right-click the polices and select Deactivate. 

For command-line users: 

e.	 Enter the following command: 

bpplinfo policy_name -modify -inactive


2.	 Deactivate all media servers. 

For NetBackup Administration Console users 

a.	 Open the NetBackup Administration Console on the master server 

b.	 Select Media and Device Management > Devices > Hosts from the tree on the 
left. 
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c.	 Select all of the media servers that appear in the right pane. 

d.	 Right-click the media servers and select Deactivate. 

For command-line users: 

e.	 Enter the following command: 

vmoprcmd -deactivate_host -h device_host 


3.	 Populate the database with information from the server that was designated as the 
Global Device Database Host. This server may be a master or media server, 
depending on how you have configured your environment. 

In a non-clustered environment, perform the following steps: 

a.	 If this is a master server, start the NetBackup bprd daemon:


/usr/openv/netbackup/bin/initbprd


b.	 Run the nbpushdata command:


/usr/openv/netbackup/bin/nbpushdata -add 


c.	 Stop the NetBackup and Media Manager daemons: 

/usr/openv/netbackup/bin/bp.kill_all


d.	 Start the NetBackup and Media Manager daemons. 

/usr/openv/netbackup/bin/goodies/netbackup start


In a clustered environment, perform the following on the active node: 

a.	 Run the nbpushdata command.


/usr/openv/netbackup/bin/nbpushdata -add 


b.	 Bring the NetBackup group offline and online. 

Refer to the NetBackup High Availability System Administrator’s Guide for 
instructions on how to bring your cluster offline and then online again after 
running the nbpushdata command. 

4.	 Populate the EMM database with information from each of the remaining master 
server(s) in your NetBackup environment. 

In a non-clustered environment, perform the following steps: 
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a.	 Start the NetBackup bprd daemon.


/usr/openv/netbackup/bin/initbprd


b.	 Run the nbpushdata command.


/usr/openv/netbackup/bin/nbpushdata -add 


c.	 Stop the NetBackup and Media Manager daemons. 

/usr/openv/netbackup/bin/bp.kill_all


d.	 Start the NetBackup and Media Manager daemons. 

/usr/openv/netbackup/bin/goodies/netbackup start


In a clustered environment, perform the following on the active node: 

a.	 Run the nbpushdata command.


/usr/openv/netbackup/bin/nbpushdata -add 


b.	 Bring the NetBackup group offline and online. 

Refer to the NetBackup High Availability System Administrator’s Guide for 
instructions on how to bring your cluster offline and then online again after 
running the nbpushdata command. 

5.	 Populate the EMM database with information from the Volume Database Host(s). 
(This step is only necessary if you have a Volume Database Host on a media server.) 

In a non-clustered environment, perform the following: 

a.	 Run the nbpushdata command.


/usr/openv/netbackup/bin/nbpushdata -add 


b.	 Stop the NetBackup and Media Manager daemons. 

/usr/openv/netbackup/bin/bp.kill_all


c.	 Start the NetBackup and Media Manager daemons. 

/usr/openv/netbackup/bin/goodies/netbackup start


In a clustered environment, perform the following on the active node: 

a.	 Run the nbpushdata command.


/usr/openv/netbackup/bin/nbpushdata -add 


b.	 Bring the NetBackup group offline and online. 
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Refer to the NetBackup High Availability System Administrator’s Guide for 
instructions on how to bring your cluster offline and then online again after 
running the nbpushdata command. 

6.	 Populate the EMM database with information from each of the media server(s) in 
your NetBackup environment that you chose to upgrade to NetBackup 6.0. 

In a non-clustered environment, perform the following steps: 

a.	 Run the nbpushdata command on the upgraded media server.


/usr/openv/netbackup/bin/nbpushdata -add 


b.	 Stop the NetBackup and Media Manager daemons. 

/usr/openv/netbackup/bin/bp.kill_all


c.	 Start the NetBackup and Media Manager daemons. 

/usr/openv/netbackup/bin/goodies/netbackup start


In a clustered environment, perform the following on the active node: 

a.	 Run the nbpushdata command.


/usr/openv/netbackup/bin/nbpushdata -add 


b.	 Bring the NetBackup group offline and online. 

Refer to the NetBackup High Availability System Administrator’s Guide for 
instructions on how to bring your cluster offline and then online again after 
running the nbpushdata command. 

▼	 To configure 5.x media servers for compatibility with 6.0 environments 

NetBackup 6.0 provides backlevel support for media servers running NetBackup 
5.0MP4 (or later) or 5.1. This enables you to upgrade some or all of your media servers 
to NetBackup 6.0 at a later time. However, you must modify the configuration slightly 
so version 5.x media servers work in the NetBackup 6.0 environment. 

1.	 Run the nbpushdata -modify_5x_hosts command on the NetBackup 6.0 master 
servers that administer the media servers that you want to remain at version 5.x. 

Note	 The command option is literally modify_5x_hosts, and uses the character x 
rather than a version number. Do not type either modify_50_hosts or 
modify_51_hosts. 

/usr/openv/netbackup/bin/nbpushdata -modify_5x_hosts
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2.	 Repeat step 1 on any additional master servers that administer media server(s) you 
are not upgrading to version 6.0. You only need to run this command once on each 
applicable master server. 

Upgrading Clients After Servers Are Upgraded 
The update_clients installation script enables you to push client software to clients. It 
does not enable you to push client software to a remote client that is also a NetBackup 
media or master server. You cannot push software this way because the server software 
and client binaries must be of the same release/revision level on a single host. 

When run on a master server, the update_clients installation script is able to 
determine the full client list that is configured on the server. When it is run without any 
parameters, it attempts to update all clients (as determined by 
/usr/openv/netbackup/bin/admincmd/bpplclients). If you do not want to 
upgrade all clients, you can specify a subset of clients by using the hardware type and 
operating system parameters or by using the -ClientList parameter. 

As of NetBackup 6.0, it is possible to run update_clients on a media server. The 
-ClientList parameter is required in this situation. The script lets you maintain a 
media server and a set of clients at an earlier release level than the master server. Doing so 
requires the informed use of the update_clients -ClientList command on both 
master and media server so as not to inadvertently upgrade clients that you do not intend 
to upgrade. 

▼	 To upgrade clients after you have upgraded servers 

Note For clustered environments: You can push client software only from the active node. 

1.	 Mount the client CD. 

A menu appears that displays the available client types. 

2.	 Change your working directory to the CD directory if you have a CD or to the 
directory that contains the downloaded files: 

cd /cd_mount_point


The cd_mount_point is the path to the directory where you can access the CD. 

3.	 Enter the following command to run the installation script: 

./install
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Note	 The binaries provided for the client operating system levels represent the 
operating system levels on which the binaries were compiled. Often the binaries 
function perfectly on later versions of the operating system. For example, 
Solaris 9 binaries also are used on the Solaris 10 level of the operating system. 
The installation script attempts to load the appropriate binaries for your system. 
If the script does not recognize the local operating system, it presents choices. 

4. Select the client type that you want to load and follow the prompts to install that client 
type. Repeat as necessary until all desired client types have been loaded. 

Note	 Make sure you load the software for all the UNIX client types you intend to 
back up onto the server. Otherwise, you cannot add these client types to the 
NetBackup policy configuration. 

5.	 After the installation is complete, unmount the client CD. 

6.	 As a root user on the NetBackup master server, check whether bprd is running: 

/usr/openv/netbackup/bin/bpps 

7.	 If only one bprd appears in the bpps output, there are no active backups or restores. 
Terminate the bprd daemon: 

/usr/openv/netbackup/bin/admincmd/bprdreq -terminate


8.	 Update UNIX client software by running the update_clients script with one of the 
following commands: 

Note Specify the host names of the individual nodes (not virtual names) in the list of 
clients. 

Note The update_clients script does not enable you to push client software to remote 
media or master servers. 

◆	 If you are not using a -ClientList file, run the following command: 

/usr/openv/netbackup/bin/update_clients 

◆	 If you are using a -ClientList file run the following command: 

/usr/openv/netbackup/bin/update_clients -ClientList filename 

Note The -ClientList parameter is required on a media server. 
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Note For more than 30 clients, you can divide the list into multiple files and run 
update_clients for each file. 

To create a client list file, perform the following steps: 

a.	 Change to the NetBackup admincmd directory, as follows: 

cd /usr/openv/netbackup/bin/admincmd 

b.	 Use the bpplclients(1M) command to create a file that contains a list of clients 
currently configured in the NetBackup database. 

The options to use on this command differ depending on whether you are 
pushing from a master server or from a media server, as follows: 

◆	 If you are pushing from the master server, run the following command: 

./bpplclients -allunique -noheader > file


◆	 If you are pushing from a media server, run the following command: 

./bpplclients -allunique -noheader -M m_server_name > file


m_server_name	 Name of the NetBackup master server in this environment. 

file	 Name of the file to contain the list of unique clients. If no clients 
have been configured in the NetBackup database, file is empty. 
Create file using the same format as that generated by 
bpplclients. 

The bpplclients command writes output to file in the following format: 

hardware os client 

hardware	 The hardware name. For examples, run the ls(1) command in directory 
/usr/openv/netbackup/client. 

os	 The operating system name. For examples, run the ls(1) command in 
directory /usr/openv/netbackup/client/hardware. 

client	 The name of the client. 

The contents of file might look like the following example: 

Solaris Solaris8 curry
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c.	 (Optional) Edit file. 

Perform this step to change the contents of file. Edit file to contain only those 
clients you want to update with NetBackup client software. 

The host names of the clients must be the clients’ individual node names. They 
cannot be virtual names. The correct value for the individual node names is 
returned by the hostname(1) and the domainname(1) commands. The format 
can be either hostname or hostname.domainname. 

9.	 The update_clients script requests information from you. The following

information appears in the script:


Starting update_clients script.

There are N clients to upgrade.

Do you want the bp.conf file on the clients updated to list this 

server as the master server? (y/n) [y]


Answer either y or n. 

Enter the number of simultaneous updates you wish to take place. 

[1 - 30] (default: 15):


Press Enter (or Return). 

The upgrade will likely take Y to Z minutes.

Do you want to upgrade clients now? (y/n) [y]


Answer either y or n. 

10. After all of the servers and clients have been updated, start NetBackup and Media 
Manager daemons as the root user on the master server: 

/usr/openv/volmgr/bin/ltid

/usr/openv/netbackup/bin/initbprd


11. After you have upgraded the NetBackup software, proceed to.“Completing Your 
System Update After an Upgrade” on page 65. 

Upgrading a NetBackup Server to NetBackup Enterprise 
Server 

Note A NetBackup Server cannot be upgraded to a clustered NetBackup Enterprise 
Server. You must perform a new cluster installation of NetBackup Enterprise Server. 
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Note	 When you install NetBackup Enterprise master or media servers, you must enter a 
NetBackup Enterprise server product license key. On the master server, you must 
also enter license keys for any additional NetBackup software product options or 
agents used on the server or its clients. 

1.	 Ensure that you have license keys for all the NetBackup servers, clients, options, and 
agents that you ordered. 

For more information on administering NetBackup licenses, see the NetBackup System 
Administration Guide, Volume I. 

Note	 After making and saving any license key updates (including adding and deleting 
license keys) in the NetBackup Administration Console, you must restart the 
console. 

2.	 Reinstall NetBackup, using the instructions from “Upgrading NetBackup on UNIX 
Servers and Clients” on page 35. 

3.	 When prompted, enter the license key.


NetBackup Enterprise software installs.


Completing Your System Update After an Upgrade 
◆	 Upgrade any separately-priced options (such as NetBackup for Oracle) on clients that 

have been upgraded. Separately-priced options should be at the same level as the 
NetBackup client. 

◆	 If you made changes to NetBackup scripts prior to the upgrade, apply those changes 
to the new, upgraded versions of the scripts. 

◆	 If this is a master server upgrade installation and you had previously allowed nonroot 
users to administer NetBackup, the default permissions and group on the newly 
installed files allow only a root user to perform NetBackup administration. 

◆	 During installation, NetBackup overwrites the following files. Before overwriting the 
files, it appends the version to the name and copies the renamed files to a file or 
directory. 

◆	 All files in the /usr/openv/netbackup/bin/goodies directory and the 
/usr/openv/netbackup/help directory. 

◆	 Some files and directories in /usr/openv/volmgr. 
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◆	 The following scripts from the /usr/openv/netbackup/bin directory: 

backup_notify 
backup_exit_notify 
bpend_notify (present only if used) 
bpend_notify_busy (present only if used) 
bpstart_notify (present only if used) 
dbbackup_notify 
diskfull_notify 
initbpdbm 
initbprd 
restore_notify 
session_notify 
session_start_notify 
userreq_notify 

For example, an upgrade from NetBackup 5.1GA to NetBackup 6.0 would result 
in renaming the following directory: 

/usr/openv/netbackup/bin/goodies


The directory’s new name might be like the following: 

/usr/openv/netbackup/bin/goodies.5.1GA


◆	 The following scripts from the /usr/openv/volmgr/bin/goodies directory: 

drive_mount_notify (present only if used) 
drive_unmount_notify (present only if used) 

◆	 The following scripts from the /usr/openv/volmgr/bin directory: 

shared_drive_notify 

Installing NetBackup Agents and Options After an Upgrade 
After your upgrade is complete, you can install any other NetBackup agents and options 
(such as NetBackup for Oracle) by following the instructions in the NetBackup System 
Administrator’s Guide that comes with that product. 
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4 

This chapter gives instructions for uninstalling NetBackup 6.0 software from your server 
system. 

During each procedure, you have the opportunity to save any data that you want and 
uninstall add-on products before uninstalling NetBackup. 

Caution	 When you complete the procedures in this chapter, you remove NetBackup, any 
add-on products, and any associated databases, including VERITAS Storage 
Migrator. VERITAS recommends that you save the data that you require and 
uninstall any add-on products before you uninstall NetBackup. 

Uninstalling NetBackup on Solaris Servers 
The information in this section explains how to remove NetBackup from a Solaris server. 
This procedure outlines the basic steps that you need to perform, and it may require that 
you reference other documents for procedures of specific tasks; for example, both volumes 
of the NetBackup System Administrator’s Guide contain information on much of what you 
need to do to uninstall the software. 

Note	 If you have moved the catalog database files in /usr/openv/db/data to another 
location, refer to the NetBackup System Administration Guide, Volume I for procedures 
on how to remove those files. 

Note	 For clustered environments: Before you begin this procedure, you must remove 
NetBackup from the cluster application. Follow the instructions in your cluster 
documentation for removing a group, then continue with removing NetBackup. 

You must uninstall NetBackup from each node in the cluster. 
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Note	 If you identified an alternate root path in your NetBackup 6.0 install or upgrade, the 
process prompts you with the alternate root path, enabling you to use the 
pkgrm -R command from the alternate root location. The pkgrm -R command 
was implemented starting with the NetBackup 5.0 VRTSnetbp (NetBackup server) 
package. You cannot use pkgrm -R with VRTSnetbp packages that were released 
prior to NetBackup 5.0. This feature applies to NetBackup server only, and not 
add-ons, clients, or database agents. 

▼	 To uninstall NetBackup from a Solaris server 

1.	 Log on as the root user on the server. 

2.	 Perform a catalog backup. 

3.	 Remove add-on products. 

To find out which NetBackup packages are installed on your system, run 
pkginfo(1). 

a.	 Important - Save all important data from any add-on products you have installed. 
For instructions on how to migrate files to a secondary storage device, refer to the 
VERITAS Storage Migrator Administrator’s Guide. 

b.	 Uninstall each add-on product. 

◆	 For instructions on uninstalling VERITAS Storage Migrator, refer to the 
VERITAS Storage Migrator Administrator’s Guide. 

◆	 For instructions on uninstalling NetWare Media Server, refer to the NetBackup 
NetWare Media Server Option System Administrator’s Guide. 

◆	 For instructions on uninstalling NetBackup Encryption, refer to the NetBackup 
Encryption System Administrator’s Guide. 

4.	 Stop the NetBackup/Media Manager daemons: 

/usr/openv/netbackup/bin/goodies/bp.kill_all


5.	 Remove the NetBackup package.


If it exists, remove the following file:


rm -f /usr/openv/bin/driver/snapctl10_x


Run pkgrm:


pkgrm VRTSnetbp
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6.	 You see the following prompts: 

Is this an upgrade?


Answer no. 

Remove references to NetBackup/Media Manager from services and

inetd config files?


Answer yes. 

Remove non-empty directories?


Answer yes. 

Note	 When you remove NetBackup, PBX is not removed. If you would like to 
permanently clean your system, refer to the PBX documentation stored on your 
platform-specific ICS CD. 

7.	 Remove the startup scripts, as follows: 

rm -f /etc/rc2.d/S77netbackup 

rm -f /etc/rc0.d/K01netbackup 

rm -f /etc/init.d/netbackup 

8.	 Run the following commands to remove the NetBackup-Java application state data 
for the root account: 

Note	 There is no space between the slash character (/) and the period or dot 
character (.) of “/.nbjava”. Adding a space between these characters 
removes all of your files starting from the root level. 

/bin/rm -rf /.nbjava 

/bin/rm -rf /.java/.userPrefs/vrts 


9.	 Inform NetBackup-Java users that they can remove their $HOME/.nbjava and 
portions of $HOME/.java directories. 

The $HOME/.nbjava and $HOME/.java directories contain application state 
information (for example, table column order and size) that is saved when the user 
exits NetBackup-Java applications. The process removes this directory for the root 
user only. 

The common subdirectory in $HOME/.java/.userPrefs/vrts can be removed. 

10. If you enabled NetBackup access control, NetBackup placed several files on clients 
and servers. 
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These files can be divided into two categories: individual user files, and NetBackup 
application temporary files. NetBackup application temporary files are removed with 
NetBackup. Users’ cache files exist in a directory named $HOME/.vxss. 

Inform users that they can remove $HOME/.vxss directory. 

Note	 Files are generated in the /.vxss directory by a single sign-on operation of the 
NetBackup Administration Console on the host where the console runs. 
NetBackup Administration Console cleans these files when an exit function is 
performed. (It is common to have no temporary files in this directory.) If a 
system crash were to occur, these files may be left behind. With the console 
shutdown, you can delete these files safely with no data loss. 

NetBackup also creates cached certificates for client and server NetBackup 
applications. These files reside within the /.vxss directory. These files typically have 
a name that is consistent with a DNS entry for a network interface, as in 
machine.company.com. 

Example directory entries are as follows: 

/usr/openv/var/vxss/credentials/machine.company.com

/usr/openv/var/vxss/credentials/dhcp


These files are created with the command bpnbat -LoginMachine. If you are 
considering a reinstallation of NetBackup at a later date on the machine in question, 
preserve the certificates in the vxss/credentials directory or be prepared to 
provide the machine identity password as originally set on the Root+AB broker. As an 
alternative, you can may reset the password on the Root+AB broker when you 
reinstall. For more information on Root+AB brokers, please see the VERITAS Security 
Services Administrator’s Guide. 

Note	 For more information on NetBackup access control, see the NetBackup System 
Administration Guide, Volume II. For information on the VERITAS Security 
Services, including how to properly remove it, see the VERITAS Security Services 
Administrator’s Guide. 

Uninstalling NetBackup on All Other UNIX Servers 

Note	 If you have moved the catalog database files in /usr/openv/db/data to another 
location, refer to the NetBackup System Administration Guide, Volume I for procedures 
on how to remove those files. 
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Note	 For clustered environments: Before you begin this procedure, you must remove 
NetBackup from the cluster application. Follow the instructions in your cluster 
documentation for removing a group, then continue with removing NetBackup. 

Note	 When uninstalling NetBackup from an HP-UX Service Guard Cluster in which 
NetBackup has been configured to run as a clustered package, you must also delete 
the /etc/cmcluster/netbackup directory. 

▼	 To uninstall NetBackup from a UNIX server other than Solaris 

1.	 Log on as the root user on the server. 

2.	 Perform a catalog backup. 

3.	 Stop the NetBackup/Media Manager daemons: 

/usr/openv/netbackup/bin/goodies/bp.kill_all


4.	 Run the following command to unregister NetBackup from the VxUL master 

configuration stored in the /etc/vx/vrtslog.conf file. 


/usr/openv/netbackup/bin/vxlogcfg -r -p 51216 

The -p option specifies the product ID, which is 51216 for NetBackup. 

5.	 Remove add-on products: 

a.	 Important: Save all important data from any add-on products installed. If you use 
VERITAS Storage Migrator, refer to the VERITAS Storage Migrator Administrator’s 
Guide for instructions on how to migrate files to a secondary storage device. 

b.	 Uninstall each add-on product. For instructions on uninstalling VERITAS Storage 
Migrator, refer to the VERITAS Storage Migrator Installation Guide. 

6.	 Remove the NetBackup databases by running the following command (this removes 
the databases even if they have been moved from their default locations): 

/usr/openv/db/bin/create_nbdb -drop_only


7.	 To remove references to NetBackup/Media Manager from /etc/services and the 
[x]inetd configuration files, run the edit_services script: 

/usr/openv/netbackup/bin/goodies/edit_services.
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Note	 When you remove NetBackup, PBX is not removed. If you would like to 
permanently clean your system, refer to the PBX documentation stored on your 
platform-specific ICS CD. 

8.	 Remove the /usr/openv directory. 

◆	 If /usr/openv is a physical directory, run the following command: 

rm -rf /usr/openv 

◆	 If /usr/openv is a link, run the following commands: 

cd /usr/openv

pwd

ls


Caution	 Make sure you are at the proper location and verify that the subdirectories are 
what you would expect them to be before continuing. You do not want to 
remove the wrong directories. This is why the first commands verify your 
current location and the files in that directory before removing files. 

rm -rf *

cd /

rm -f /usr/openv


Caution The rm -f /usr/openv command also removes any add-on products 
installed on this machine. 

9.	 For Linux systems only: 

If you modified the startup and shutdown scripts as described in “Configuring 
System Startup and Shutdown of NetBackup” on page 101, run the following 
command: 

/sbin/chkconfig --del netbackup


10. Remove the following links and files: 

System Additional Files 

AIX /etc/rc.veritas.aix 

Alpha Tru64 /sbin/rc3.d/S77netbackup 
/sbin/rc0.d/K01netbackup 
/sbin/init.d/netbackup 
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System Additional Files 

HP-UX /sbin/rc2.d/S777netbackup (note three 7s) 
/sbin/rc1.d/K001netbackup 
/sbin/init.d/netbackup 

Linux Red Hat /etc/rc.d/rc2.d/S77netbackup 
/etc/rc.d/rc3.d/S77netbackup 
/etc/rc.d/rc5.d/S77netbackup 
/etc/rc.d/rc6.d/K01netbackup 
/etc/rc.d/rc0.d/K01netbackup 
/etc/rc.d/init.d/netbackup 

Linux SuSE /etc/init.d/rc2.d/S77netbackup 
/etc/init.d/rc3.d/S77netbackup 
/etc/init.d/rc5.d/S77netbackup 
/etc/init.d/rc6.d/K01netbackup 
/etc/init.d/rc0.d/K01netbackup 
/etc/init.d/netbackup 

Other servers /etc/rc2.d/S77netbackup 
/etc/rc0.d/K01netbackup 
/etc/init.d/netbackup 

11. For AIX systems only: 

Remove the NetBackup /etc/rc.veritas.aix entry from /etc/inittab file. 

Remove the line /etc/rc.veritas.aix stop in the /etc/rc.shutdown file. 

12. Run the following commands to remove the NetBackup-Java application state data 
for the root account: 

/bin/rm -rf /.nbjava 

/bin/rm -rf /.java/.userPrefs/vrts 


13. Inform NetBackup-Java users that they can remove their $HOME/.nbjava directory. 

The $HOME/.nbjava directory contains application state information (for example, 
table column order and size) that is saved when the user exits NetBackup-Java 
applications. The process removes this directory for the root user only. 

The common subdirectory in $HOME/.java/.userPrefs/vrts can be removed. 
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NetBackup License Keys 
5 

This chapter contains basic information for entering license keys and provides answers to 
some frequent asked questions. 

For detailed information and procedures on how to administer license keys, refer to the 
both volumes of the NetBackup System Administrator’s Guide, Volume 1. 

NetBackup License Compatibility 
NetBackup 6.0 enables all existing permanent license keys to remain valid. 

Before NetBackup release 5.0, NetBackup had separate licenses for NetBackup 
DataCenter, NetBackup BusinesServer, servers, database agents, and options. 

The NetBackup Enterprise Server is the next generation of the DataCenter product and 
the NetBackup Server is the next generation of the BusinesServer product. The 
DataCenter and BusinesServer keys work for NetBackup Enterprise Server and 
NetBackup Server, respectively. 

Database agents or options do not have separate license keys or separate pricing. For 
example, there is one Oracle Agent available for purchase to use with either NetBackup 
Enterprise Server or NetBackup Server. 

Entering License Keys 
During the installation of NetBackup on a master server, it is easiest for you enter all of 
your license keys when you are prompted by the installation script. 

If you did not enter all of your license keys, you can open the NetBackup Administration 
Console (Windows or UNIX) and select Help > License Keys... 

On UNIX servers, you can also run the following command: 

/usr/openv/netbackup/bin/admincmd/get_license_key


Note All product license keys must be entered on the master server. 
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Some features and products also require the keys to be installed on the media server. The 
following features require keys to be installed on media servers and master servers: 

◆ NetBackup Shared Storage Option (SSO) 

◆ Library-based Tape Drives Feature 

◆ NDMP 

You can log in to a NetBackup server from almost any server within a system to view, 
enter, and administer licenses. Because of this, if you are attempting to administer license 
keys remotely, you must be sure you are viewing the licenses of the system you intend to 
change to avoid adding or changing a license on the wrong server. 

Frequently Asked Questions 
VERITAS customers have asked the following questions about managing license keys. 

Is NetBackup's licensing the same as the licensing in other VERITAS products? 

NetBackup is implementing the common licensing system used by other VERITAS 
products. This licensing system was developed in-house; it is not from a third party. 
However, please note that different VERITAS products have different requirements and 
our common licensing system provides considerable flexibility in what licensing features 
are implemented in each product. For example, NetBackup does not have a node-locked 
licensing system, but some other VERITAS products may. 

Can I use NetBackup if all I have is a media/doc kit? 

No. The media/doc kit by itself does not allow any access to NetBackup. You always need 
a license key (either permanent or evaluation). License keys should always be delivered 
with the media/doc kit, so you should never find yourself with a media/doc kit and no 
key. 

What does the license key look like? What information does it contain? 

The key is a multi-digit alphanumeric string (for example: 
8EPP-ABCD-9XYZ-XYZ9-8881-VCF4-OIUF-AJDC). It contains information on whether 
the key is for NetBackup Server or NetBackup Enterprise Server, whether it is for a server, 
client, agent, or option (and which one), whether it is a permanent or evaluation, and 
information about how and where the key was generated. 

Is the license key serialized? 

Yes, there is serialization information embedded in the key. 

Can I see reports on what keys I have? 

Yes. Information about the keys is stored on the master server. 
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To access the information, open the NetBackup Administration Console (Windows or 
UNIX) and select Help > License Keys.... 

On UNIX servers, you can also run the following command: 

/usr/openv/netbackup/bin/admincmd/get_license_key


If you are currently on a media server, you must enter the master server name when 
prompted for the host name. For more information on how to view reports, refer to both 
volumes of the NetBackup System Administrator’s Guide. 

How do I enable options and agents? 

When you install NetBackup, you are prompted to enter all keys for options and agents.


If you purchase an agent or option at a later date, open the NetBackup Administration 

Console (Windows or UNIX) and select Help > License Keys.... 


On UNIX servers, you can also run the following command:


/usr/openv/netbackup/bin/admincmd/get_license_key


If you are running the NetBackup Administration Console on a media server, you must 
enter the master server name when prompted for the host name in the Login screen. 

Many options and agents require you to have your original NetBackup distribution CDs, 
because additional binaries need to be installed. You should always keep your NetBackup 
CDs in a safe and accessible place. 

Should I save keys after they have been entered? 

Yes. Always store copies of the keys in a secure place. 

What should I do if I have lost my license key(s)? 

VERITAS has a record of all keys issued to VERITAS customers. Customers who lose their 
license key(s) can call Order Management to get copies of their keys. 

For Americas, Japan, PacRim, Australia: 
Tel: 650.318.4265     FAX: 650.335.8428 

For Europe, Middle East and Africa: 
Tel: 00.353.61.365232 FAX: 00.353.61.365223 

If you have purchased NetBackup from a VERITAS partner, you need to contact that 
partner for information on your key. 

How are large volume orders handled? 

VERITAS recognizes that many NetBackup installations are very large, and entering long 
license keys multiple times can be tedious and time-consuming. You can request a single 
key for each type of NetBackup component purchased. For example, a customer who is 
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ordering 50 Lotus Notes agents can obtain a single key with a certificate stating that the 
key may be used for 50 Lotus Notes licenses. Site licenses, that enable unrestricted use for 
specific NetBackup agents or options can be handled in this manner. 

Note You still need a unique key for each type of NetBackup component purchased - 
NetBackup server, Lotus Notes agent, NDMP option, UNIX client, and so on. 

What about license keys for customers with site licenses? 

Site licenses are handled the same way that large volume orders are; however, instead of 
the certificate stating that the license key is good for a specific number of copies, the 
certificate states that the license key is good for unlimited copies of the NetBackup 
component. 

Do I need a license key to enable NetBackup Remote Administration Consoles? 

No. There are no special license keys for NetBackup Remote Administration Consoles. 
You can install them on any computer with access to the master server. 

Can a key be used multiple times? 

Yes. The keys may be used multiple times; however, you are legally bound to install and 
use only the number of NetBackup servers, clients, agents, and options for which you 
have purchased licenses. 

How do existing customers get keys? 

All NetBackup customers who have current maintenance contracts with VERITAS 
automatically receive the latest version of NetBackup. You receive the NetBackup 
Enterprise Server or NetBackup Server media/doc kit and license keys for every 
NetBackup component for which VERITAS records indicate you have purchased licenses. 

If your maintenance is through a VERITAS partner, you upgrade through the partner. 
Contact the partner for more details. 

What if I do not get the right keys? 

If you believe you are entitled to a key that you did not receive, you should contact the 
Order Management number provided on your license key certificate. 

Note	 VERITAS Technical Support does not issue permanent keys. This can only be done 
through VERITAS Order Management. However, Technical Support is prepared to 
provide temporary one-month keys to you while issues regarding permanent 
license keys are resolved. 
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What does an evaluation key enable? 

The evaluation key enables unrestricted use of NetBackup Server or NetBackup 
Enterprise Server, as well as any of their options and agents, for a predetermined period of 
time. 

Am I notified when an evaluation is about to expire? 

You can find information about when a key expires by opening the About box in the 
NetBackup Administration Console (Windows or UNIX), or you can find it on your 
system logs. 

On UNIX servers, you can also run the following command: 

/usr/openv/netbackup/bin/admincmd/get_license_key


If you are running the NetBackup Administration Console on a media server, you must 
enter the master server name when prompted for the host name in the Login screen. 

What happens when an evaluation key expires? 

The NetBackup daemons are shut down. When you attempt to use the product you are 
informed that its evaluation period has expired. 

Is backup configuration and catalog information saved when evaluation keys expire? 

Yes. Customers who add a permanent license key to an evaluation version of NetBackup 
have immediate access to their catalog and configuration information. 

How do I upgrade from an evaluation license to a permanent license? 

It is easy. When you purchase a permanent license, you add that license to NetBackup. All 
the configuration information and catalog data from your evaluation version is retained. 

To enter your permanent key, open the NetBackup Administration Console (Windows or 
UNIX) and select Help > License Keys.... 

On UNIX servers, you can also run the following command: 

/usr/openv/netbackup/bin/admincmd/get_license_key


If you are running the NetBackup Administration Console on a media server, you must 
enter the master server name when prompted for the host name in the Login screen. 
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6 

This chapter discusses how to install NetBackup client software for the following 
NetBackup clients: 

◆ Microsoft Windows clients 

◆ UNIX clients (including MacOS X 10.3.x) 

For the NetBackup’s Novell NetWare Client: See the NetBackup Novell NetWare Client System 
Administrator’s Guide for formation on how to install, configure, and use NetBackup’s 
Novell NetWare Client to back up and restore data that resides on a NetWare file server. 

Note	 For clustered environments: During the installation, enter the virtual name for the 
NetBackup server and not the actual local host name. 

You can push client software only from the active node. 

Note	 For Macintosh OS X 10.3.x clients: Macintosh clients are considered UNIX-based 
clients. The instructions for installation are provided in “Installing NetBackup 
Clients on UNIX Systems” on page 89. 

Installing NetBackup on Microsoft Windows Clients 
By definition, your NetBackup server is also a NetBackup client. When you installed the 
NetBackup server software, you installed both the NetBackup server and NetBackup client 
software on the server. 

Windows Client Installation Overview 
The NetBackup client setup program for Microsoft Windows allows you to select 
appropriate setup and installation options from a series of wizard screens. Once the 
options have been selected, the NetBackup client setup program displays a window that 
enables you to verify your selections before continuing with the actual installation. 
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While the installation is in progress, a dialog provides details of the installation and setup 
progress. When complete, a final window indicates the results of the installation. 

Note	 You cannot install NetBackup client software on PCs that currently have NetBackup 
server software installed. In these cases, you must first uninstall the NetBackup 
server software, as described in the NetBackup Installation Guide for Windows. 

VERITAS Volume Snapshot Provider on Windows 

If you install the software on a Windows client, during the installation process you have 
the option of installing VERITAS Volume Snapshot Provider (VSP). VSP establishes a 
point-in-time view, or snapshot, of the data that is selected for backup on the volumes 
(that is, drives). NetBackup then backs up the selected files as they existed at the time of 
the snapshot, regardless of file system activity. VSP uses a file system cache to store 
changes that occur during the backup. Each volume for which a snapshot is created will 
have a corresponding VSP cache file. 

For information on the VSP parameters, please refer to the NetBackup Backup, Archive, and 
Restore Getting Started Guide. In addition, refer to the both volumes of the NetBackup System 
Administrator’s Guide, Volume 1. 

User-Directed Operations for Windows Systems 

By default on Windows 2000, Windows XP, or Windows 2003 Server systems, the 
Program Files folder is not writable by users other than the administrator. 

By default NetBackup writes log files and progress files to the folder 
Program Files\VERITAS\NetBackup\Logs. Users without write permission to the 
Logs folder receive an error message when they attempt a backup or restore and the 
operation is aborted. 

If users other than the administrator use the Backup, Archive, and Restore interface to 
perform backups and restores, make sure they have write permission to the Logs 
directory. 

Local and Remote Installations for Windows Systems 

The NetBackup client setup program can be used in either of the following ways: 

◆	 Local installations: The setup program installs the client software only on the machine 
where you start the installation. 

◆	 Remote installations: The setup program scans the network for available clients on 
which you can install the client software. The source machine (in cluster 
environments, primary node) must have Windows 2000, Windows XP, or Windows 
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2003 server installed. In addition, a remote installation requires system administrator 
privileges and is only available for Windows 2000, 32-bit Windows XP, and 32-bit 
Windows 2003 machines. 

Note You cannot remotely install from UNIX systems to Windows 2000, 
Windows XP, or Windows 2003 machines. 

Local and remote installations can be either new or upgrade installations, depending on 
whether there is any existing NetBackup client software installed on the client PCs. 

Silent Installations for Windows Systems 

A silent installation is one in which the installation process does not require interactive 
input. It does, however, require that the silentclient.cmd file be edited before 
executing the file. 

New and Upgrade Installations for Windows Clients 

The NetBackup client setup program recognizes two types of installations: 

◆	 New installations: The setup program does not detect an existing version of 
NetBackup client software. 

◆	 Upgrade installations: Using Windows registry information, the setup program 
detects an existing version of NetBackup client software. 

New Installations 

NetBackup setup enables you to specify one set of configuration options to be used for all 
new installations. These options include the following: 

◆	 For typical and custom installations, specifying master and media server names 

◆	 For custom installations only, you have the following options: 

◆	 Specifying an installation directory (local install only) 

◆	 Entering bpcd and bprd port numbers 

◆	 Starting the NetBackup Client Service automatically or manually 

◆	 Starting the NetBackup Client Service on the client after installation is complete 

◆	 Starting the NetBackup Client Job Tracker automatically 

◆	 Installing VSP 

◆	 Installing debug symbols 

◆	 Installing the NetBackup documentation 
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Note	 For upgrading existing installations: The setup program lets you specify the same 
options as you specify for new installations, except that you cannot change the 
location of the installation. 

Windows Client System Requirements 
This section describes the hardware and software that is required for successful

installation of NetBackup client software.


Windows Client Installation Requirements 

To install NetBackup client software, the system must meet the following configuration 
requirements. 

◆	 Microsoft Windows (2000, XP (32- and 64-bit), and 2003 Server (32- and 64-bit)) 

◆	 Windows 2000 (service pack 2) installed. 

◆	 An Intel Pentium or Itanium processor 

◆	 Internet Explorer 5.5 or later 

◆	 Any TCP/IP transport that is Windows Sockets Compliant. (Use of the TCP/IP 
transport that comes with the server or operating system is recommended.) 

◆	 A network adapter supported by your TCP/IP transport. 

Remote Windows Client Installation Requirements 

In addition to the previous requirements: 

◆	 The source system must have Windows 2000, Windows XP, or Windows 2003 Server 
installed. 

◆	 The destination system must have Windows 2000, 32-bit Windows XP, or 32-bit 
Windows 2003 client installed. 

◆	 The person performing the remote installation must have administrator privileges on 
all of the client systems. 

NetBackup Server Requirements 

The version of the NetBackup server software must be the same or newer than the version 
you install on the client. 
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Windows Client Local Installation Instructions 
Follow these instructions to install the NetBackup client software on your Windows 
system. You can stop the installation process at any time by clicking Cancel or clicking 
Back to return to the previous window. 

▼	 To install NetBackup client software on Windows systems 

1.	 Log in as Administrator on the Windows server. 

2.	 Insert the NetBackup installation CD in the drive. On systems with Autorun enabled, 
the installation starts automatically. If Autorun is not enabled, navigate to the CD 
drive and double-click Launch.exe. 

3.	 On the initial screen, select NetBackup Installation. 

4.	 On the installation screen, select Install Client Software.


The Welcome screen appears. Click Next.


5.	 On the License Agreement screen, accept the terms of the agreement. 

6.	 On the Installation Type screen, do the following: 

a.	 Select Install to this computer only. 

b.	 Select either a typical or custom installation. 

If you choose a typical installation, NetBackup uses the default port numbers and 
default service startup settings. 

If you choose a custom installation, you can select your service startup settings, 
change port numbers, specify the installation location, and choose whether or not to 
install NetBackup documentation, debug symbols, and VSP. 

Click Next. 

7.	 On the NetBackup System Names screen, provide the name of the client and the 
master server, and any media servers with which this client should communicate. 
Provide the media servers in the Additional servers box. 

8.	 On the Ready to Install screen, click Install.


NetBackup installs the client on the local machine.


9.	 On the System Validation Complete screen, click Finish. 
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Note You may need to reboot the system for the changes to take effect. 

Windows Client Remote Installation Instructions 

Note Review the installation “Windows Client System Requirements” on page 84 for 
remote installations before starting this procedure. 

Follow these instructions to install the NetBackup client software on selected Windows 
2000, 32-bit Windows XP, or 32-bit Windows 2003 Server clients on your network (one of 
these clients can be your local PC). You may stop the installation process at any time by 
clicking Cancel. 

Notes on Windows Client Remote Installations 

◆	 During installation, the client name is written to the registry in lower case. If the 
policies on the NetBackup server do not specify the client names in lower case, 
backups will fail because the names do not match. 

◆	 You must have administrator privileges on the remote client for the NetBackup install 
to complete successfully. 

◆	 The NetBackup client setup program cannot clean an aborted install. Therefore, if you 
stop Setup while it is copying files to a client, the files that have been successfully 
installed are not uninstalled. 

▼	 To install the Windows NetBackup client software on remote computers 

1.	 Log in as Administrator on the Windows server. 

2.	 Insert the NetBackup installation CD in the drive. On systems with Autorun enabled, 
the installation starts automatically. If Autorun is not enabled, navigate to the CD 
drive and double-click Launch.exe. 

3.	 On the initial screen, select NetBackup Installation. 

4.	 On the installation screen, select Install Client Software.


The Welcome screen appears. Click Next.


5.	 On the License Agreement screen, accept the terms of the agreement. 

6.	 On the Installation Type screen, do the following: 
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a. Select Select from available computers on the network. 

Note The client is installed on the local machine unless you add it to the list of 
systems to which you are going to install. 

b.	 Select either a typical or custom installation. 

If you choose a typical installation, NetBackup uses the default port numbers and 
default service startup settings. 

If you choose a custom installation, you can choose not to install debug symbols or 
VSP, and you can change the port numbers.


Click Next. 


7.	 On the NetBackup System Names screen, provide the name of the client and the 
master server, and any media servers with which this client should communicate. 
Provide the media servers in the Additional servers box. 

8.	 On the Ready to Install screen, click Install. 

NetBackup installs the client on the specified machines. 

Note	 Clicking the Cancel button anytime after you have clicked the Install button 
and started the remote install process will not cancel the installation on the 
remote system that is in progress at the time Cancel is clicked. The installation 
continues until it is finished. Any remote installations that remain are not 
performed, and any remote installs that were successful to that point will 
continue to be successful. 

9. On the System Validation Complete screen, click Finish. 

Note You may need to reboot your PC or the remote systems for the changes to take 
effect. 

Silent Installation Instructions for Windows Clients 

Note	 Silent installations of NetBackup clients are not supported if you want to run the 
NetBackup services as a user rather than as a local administrator. If you want to 
install NetBackup under this circumstance, use the procedures either in “To install 
NetBackup client software on Windows systems” on page 85 or “To install the 
Windows NetBackup client software on remote computers” on page 86. 
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In a silent installation, the installation process does not require interactive input. It does, 
however, require that the silentclient.cmd file be edited before running the script. 

Follow these instructions to perform a silent installation of the NetBackup client software 
on selected Windows clients on your network (one of these clients can be the system 
running the silentclient.cmd script). 

▼	 To perform a silent installation on Windows 

1.	 Insert the NetBackup installation CD in the drive. On systems with AutoPlay enabled, 
the VERITAS NetBackup installation browser starts automatically. 

Note Do not run instmsiw.exe on Windows 2000, Windows XP, or Windows 2003 
Server systems. 

2.	 Using Microsoft Windows Explorer, navigate to the CD drive. 

3.	 Copy the contents of the PC_Clnt\ directory to a temp folder on your hard drive 
(for example, C:\temp). 

4.	 The files contained on the CD are read-only. Change the permissions for these files on 
the hard drive to allow the update. 

5.	 In the temporary directory, use a text editor to edit the silentclient.cmd file so 
the script installs the client software as you want installed. 

Note Be sure to update the client, master server, and additional servers to the minimum 
required version level of NetBackup. 

6.	 Run the silentclient.cmd script. 

7.	 Check the NetBackup Install.log log file in the following directory to verify 
that the installation was successful: 

C:\Documents and Settings\userid\Local Settings\temp


You can configure NetBackup clients by performing one of the following actions: 

◆	 To add servers or media servers, start the Backup, Archive, and Restore interface and 
from the File menu choose Specify NetBackup Machines. 

◆	 To display and change the client properties, start the Backup, Archive, and Restore 
interface and from the File menu, choose NetBackup Client Properties. 

◆	 To display and change the server properties, start the NetBackup Administration 
Console. Expand Host Properties and click on Clients. In the right pane, right-click 
on the client, and choose Properties. 
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All NetBackup servers that require access to your Windows client must be listed on 
the Servers tab in the resulting dialog. 

For more information, refer to the NetBackup Backup, Archive, and Restore Getting Started 
Guide. 

Uninstalling Windows Client Software 

▼	 To uninstall the NetBackup client software on Microsoft Windows clients 

1.	 Open the Windows Control Panel (select Start, Settings, and then Control Panel). 

2.	 Select Add/Remove Programs. 

3.	 Select VERITAS NetBackup Client. 

4.	 Click the Remove button. 

Installing NetBackup Clients on UNIX Systems 

Note Macintosh OS X10.3.x clients are UNIX-based clients. Follow the UNIX client 
installation procedures in this section. 

You can install UNIX clients either locally at the client computer or remotely from your 
UNIX NetBackup server. To have the ability to include a client in a policy, the software for 
the client type must first be loaded on the UNIX server. 

◆	 Ensure that the gzip and gunzip commands are installed on each system, and that 
the directories where the commands are installed are part of the root user’s PATH 
environment variable setting. 

◆	 For local installations: You must install the client software locally if remote installation 
is not possible. Remote installation is not possible if your NetBackup server is a 
Windows 2000 or Windows 2003 computer or if there is a firewall that prevents 
remote installation. 

To install NetBackup locally on IBM zSeries Linux clients, you must transfer the 
contents of the NetBackup CD image to a location that is readable by the virtual Linux 
environment. This can be done by using FTP or NFS mounting commands. 

◆	 For remote installations: You can push the client software from your UNIX NetBackup 
server to your UNIX client computers. This is the preferred method of installing. To 
push a UNIX client, you must first load the software for that type of UNIX computer 
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onto your UNIX server, and the UNIX client must be a true client and not a media or 
master server. For instructions on loading the software and the remote client 
installation, see “Adding a UNIX Client after Initial Server Installation” on page 95. 

Clients such as the IBM zSeries Linux may not have a locally mounted CD device, 
making it impossible to perform a standard local install. To install NetBackup to 
clients with no local CD drive, you must push the NetBackup installation from a 
UNIX master or media server. 

◆	 For instructions on how to install NetBackup on a secure client, refer to “To install 
NetBackup software on secure (non-trusting) UNIX clients from a master server” 
on page 94. 

◆	 For instructions on how to install NetBackup on a trusting client, refer to “To 
install NetBackup software on trusting UNIX clients from a master server” on 
page 91. 

To initiate a backup or a restore from a UNIX client, the following graphical interfaces are 
available: 

◆	 Clients that are compatible with NetBackup-Java may use the NetBackup-Java 
interface (jbpSA). Refer to the NetBackup Release Notes for a list of NetBackup-Java 
capable hosts. 

◆	 Clients that are not compatible with NetBackup-Java (Macintosh OS X 10.3.x, IBM 
zseries Linux, IRIX, and FreeBSD) may use the bp interface or they can login from any 
NetBackup 6.0 UNIX server’s NetBackup client console using the jbpSA command. 

Installing UNIX Clients Locally 
The following procedure will install the NetBackup client software on a local machine. 

▼	 To install UNIX client software locally 

Note	 The only way to install client software to a different location on the client is to create 
the directory where you want the software to reside and then create /usr/openv 
as a link to that directory before you install the software. 

1. Insert the NetBackup client CD into the drive on the client computer and mount it. 

Note	 For instructions on mounting the CD on your operating system, refer to the 
appropriate section of “Mounting the Software CD” on page 13. For 
information on CD contents and exact names, refer to the table “NetBackup 
Software CD Contents” on page 3. 
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2.	 Change your working directory to the CD directory if you have a CD or to the 
directory that contains the downloaded files: 

cd /cd_mount_point 


The cd_mount_point is the path to the directory where you can access the CD. 

For Macintosh OS X 10.3.x systems only: You can access the CD from the following 
location: 

cd /volumes/cd name 


3.	 Enter the following command to execute the installation script: 

./install


Note	 The binaries provided for the client operating system levels represent the 
operating system levels on which the binaries were compiled. Often the binaries 
function perfectly on later versions of the operating system. For example, 
Solaris 9 binaries also are used on the Solaris 10 level of the operating system. 
The installation script attempts to load the appropriate binaries for your system. 
If the script does not recognize the local operating system, it presents choices. 

4.	 Follow the prompts to complete the installation. 

5.	 After the installation is complete, unmount the client CD. 

Installing UNIX Client Software Remotely 
You can push the client software from a UNIX master server to either a trusting client or a 
secure client. 

A trusting UNIX client is one that has an entry for the server in its /.rhosts file. The 
/.rhosts entries enable software installation, but are not necessary for correct operation 
of NetBackup software. 

Note	 For clustered environments: During the installation, enter the virtual name for the 
NetBackup server and not the actual local host name. In addition, you can only 
push client software from the active node. 

▼ To install NetBackup software on trusting UNIX clients from a master server 

Note	 The only way to install client software to a different location on the client is to create 
the directory where you want the software to reside and then create /usr/openv 
as a link to that directory before you install the software. 
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Note	 For Macintosh OS X 10.3.x users: By default, Macintosh OS X 10.3.x does not enable 
the remote shell daemon (rshd). You must enable this daemon to perform the 
following procedure successfully. You can enable rshd by executing the following 
command: /sbin/service shell start. 

1.	 Start the NetBackup Administration Console. 

On the Login dialog, provide the name of the NetBackup server that contains the 
policy configuration with the clients. 

You can install the client software only from the NetBackup server that you specify in 
the Login dialog when starting the interface. The clients must be defined in a policy 
on this NetBackup server. 

Note Add the trusting clients to a backup policy, if this has not already been done. 

2.	 In the NetBackup Administration Console window, click on the NetBackup 
Management icon to show the available options. 

3.	 Click Policies in the left pane. The All Policies pane populates with a list of available 
policies. 

4.	 Select the master server in the All Policies pane. 
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5.	 Choose Actions > Install UNIX Client Software. 

The Install UNIX Client Software dialog appears. 
. 

6.	 In the Don’t install these clients list, select the clients you want to install and 
click Add >>. 

The clients are moved to the Install these clients list. 

7.	 To start the installation, click Install Client Software. 

Client software installation can take a minute or more per client. NetBackup writes 
messages in the Progress box as the installation proceeds. 

If the installation fails on a client, NetBackup notifies you but keeps the client in the 
policy. 


You cannot stop the installation after it has started.


During installation, NetBackup does the following:


◆	 Copies the client software from the /usr/openv/netbackup/client directory 
on the server to the /usr/openv/netbackup directory on the client, as long as 
the client is not a media or master server. 

◆	 Adds the appropriate entries to the client’s /etc/services and inetd.conf 
files or xinetd.d directory. 

8.	 After the installation is complete, click Close. 
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▼ To install NetBackup software on secure (non-trusting) UNIX clients from a master 
server 

Note	 The only way to install client software to a different location on the client is to create 
the directory where you want the software to reside and then create /usr/openv 
as a link to that directory before you install the software. 

A secure UNIX client is one that does not have an entry for the NetBackup server in its 
/.rhosts file. 

Note Add the secure clients to a backup policy, if this has not already been done. 

Note	 For Macintosh OS X 10.3.x users: By default, Macintosh OS X 10.3.x does not enable 
the FTP daemon (ftpd). You must enable this daemon to perform the following 
procedure successfully. You can enable ftpd by checking Allow FTP access in the 
sharing pane of the System Preferences application. 

1.	 Move the client software from the server to temporary space in the /tmp directory on 
the client by running the install_client_files script from the NetBackup 
server. To run this script, you must have a login ID and password that you can use to 
access the clients through FTP. 

To move software to only one client at a time, run the following command: 

/usr/openv/netbackup/bin/install_client_files ftp client user


To move software to all clients at once, run the following command: 

/usr/openv/netbackup/bin/install_client_files ftp ALL user


The options are defined as follows: 

◆	 The client argument is the host name of the client. 

◆	 The user argument is the login id required by FTP on the client. 

◆	 The ALL option specifies that you want to install all clients that are configured in 
any backup policy on the server. 

The install_client_files script prompts you for a password for each client if 
you do not have a .netrc file set up. 
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2.	 After the install_client_files script is complete, the root user on each of the 
clients must run the client_config script to complete the installation: 

sh /tmp/bp.pid/client_config


The pid is the process ID. The client_config script installs the binaries and 
updates the /etc/services and inetd.conf files or the xinetd.d directory, as 
appropriate. 

Adding a UNIX Client after Initial Server Installation 
If you add a new UNIX client type to your backup environment or forgot to select a UNIX 
client platform during your NetBackup installation, you must first load the NetBackup 
client software onto the NetBackup server. 

▼	 To add UNIX client types to servers after initial installation 

The client CD’s installation script enables you to load the client software on the server for 
each of the UNIX client types that NetBackup supports. You can then “push” this client 
software from the server to your UNIX clients. 

1.	 Mount the client CD.


A menu appears that displays the available client types. 


Note	 For instructions on mounting the CD on your operating system, refer to the 
appropriate section of “Mounting the Software CD” on page 13. For 
information on CD contents and exact names, refer to the table “NetBackup 
Software CD Contents” on page 3. 

2.	 Change your working directory to the CD directory if you have a CD or to the 
directory that contains the downloaded files: 

cd /cd_mount_point


The cd_mount_point is the path to the directory where you can access the CD. 

3.	 Enter the following command to execute the installation script: 

./install
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Note	 The binaries provided for the client operating system levels represent the 
operating system levels on which the binaries were compiled. Often the binaries 
function perfectly on later versions of the operating system. For example, 
Solaris 9 binaries also are used on the Solaris 10 level of the operating system. 
The installation script attempts to load the appropriate binaries for your system. 
If the script does not recognize the local operating system, it presents choices. 

4. Select the client type that you want to load and follow the prompts to install that client 
type. Repeat as necessary until all desired client types have been loaded. 

Note	 Make sure you load the software for all the UNIX client types you intend to 
back up onto the server. Otherwise, you cannot add these client types to the 
NetBackup policy configuration. 

5.	 After the installation is complete, unmount the client CD. 

6.	 Install the NetBackup client on the clients you specified, as described in “Installing 
UNIX Client Software Remotely” on page 91. 

Removing UNIX NetBackup Client Software 

Note If you remove NetBackup from a machine on which you have installed the 
NetBackup-Java Display Console, the console is also removed. 

▼	 To remove UNIX NetBackup client software 

1.	 Log in to the client system as the root user. 

2.	 Remove the /usr/openv directory. 

◆	 If /usr/openv is a physical directory, run the following command: 

rm -rf /usr/openv 

◆	 If /usr/openv is a link, run the following commands: 

cd /usr/openv

pwd

ls
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Caution	 Make sure you are at the proper location and verify that the subdirectories are 
what you would expect them to be before continuing. You do not want to 
remove the wrong directories. This is why the first commands verify your 
current location and the files in that directory before removing files. 

rm -rf *

cd /

rm -f /usr/openv


Caution The rm -f /usr/openv command also removes any add-on products 
installed on this machine. 

3.	 Remove NetBackup entries in the client’s /etc/services file by locating the lines 
marked by the following strings and deleting them: 

# NetBackup services#

.....

# End NetBackup services #


# Media Manager services #

....

# End Media Manager services #


If you do not see these strings, it may be because you upgraded from an earlier release 
of NetBackup. You can also remove bpcd, bpjava-msvc, bprd, vnetd, and vopied 
without searching for the #End...# strings. It is not required that you remove the 
strings from /etc/services. Any operations that access the file will function with 
or without the services being listed. 

Note	 For Macintosh OS X 10.3.x systems: The NetBackup installation updates the 
/etc/services file with these entries. However, earlier NetBackup releases 
may have updated the /services directory of the NetInfo database. To 
uninstall NetBackup and its services from one of these clients, you must use the 
NetManager utility to remove bpcd, bpjava-msvc, bprd, vnetd, and 
vopied from the /services directory in the Netinfo database. 

4.	 Remove the NetBackup entries in the /etc/inetd.conf file by deleting the lines for 
bpcd, vnetd, vopied, and bpjava-msvc. 

5.	 Ensure that the inetd daemon reads the updated inetd.conf (or inetd.local) 
file. 
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a.	 Determine the process ID of inetd. The ps command options vary from one 
UNIX operating system to another. Following are two examples. 

For most UNIX clients, run the following command: 

ps -ea | grep inetd


For MacOS X 10.3.x and FreeBSD, run the following command: 

ps -ax | grep inetd


The process ID is the first number displayed in the ps command output. 

b.	 HUP the inetd daemon, as follows. 

kill -1 process_ID 

The kill command option may vary from one client platform to another. 

6.	 For NetBackup-Java capable clients running the NetBackup Administration Console 
for UNIX, remove the NetBackup-Java state data, as follows: 

/bin/rm -rf /.nbjava

/bin/rm -rf /.java/.userPrefs/vrts


Caution	 There should be no space between the slash “/” and the period “.” of 
“/.nbjava”. Adding a space between these characters removes all of your files 
starting from the root level. 

7.	 Inform NetBackup-Java users that they can remove their $HOME/.nbjava and 
portions of $HOME/.java directories. 

The $HOME/.nbjava and $HOME/.java directories contain application state 
information (for example, table column order and size) that is saved when the user 
exits NetBackup-Java applications. The process removes this directory for the root 
user only. 

The common subdirectory in $HOME/.java/.userPrefs/vrts can be removed. 

8.	 If you enabled NetBackup Access Control, NetBackup created new files on clients and 
servers. 

These files can be divided into two categories: individual user files, and NetBackup 
application temporary files. NetBackup temporary files are removed with NetBackup. 
Users’ cache files exist in their home directories (for example, in $HOME/.vxss). 

Inform those users that they can remove their $HOME/.vxss directory. 
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For more information on NetBackup Access Control, please see the NetBackup System 
Administrator’s Guide, Volume II. For more information on VERITAS Security Services, 
including how to properly uninstall, please see the VERITAS Security Services 
Administrator’s Guide. 
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7 

This chapter describes initial configuration steps that you may want to complete after the 
NetBackup installation. 

Configuring System Startup and Shutdown of NetBackup 
You can use system startup scripts to automatically start the Media Manager and 
NetBackup daemons when the system boots and use shutdown scripts to terminate them 
at system shutdown. 

Note	 For non-cluster upgrades: Any pre-existing S77[7]netbackup, K01netbackup, or 
K001netbackup startup/shutdown scripts are saved, and the newly released 
versions of that script are installed. 

The installation process copies the appropriate startup/shutdown script from the 
/usr/openv/netbackup/bin/goodies directory to the init.d directory and creates 
links to it from the appropriate rc directory. 

Note For clustered environments: All of the startup and shutdown scripts are removed from 
the rc directories. Clustered NetBackup environments do not use these scripts. 
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The installation process installs the links to the startup/shutdown scripts on the various 
platforms as shown in the following table. 

Links to Startup and Shutdown Scripts by Platform 

Platform Links 

AIX	 /etc/rc.veritas.aix 

◆	 You must edit /etc/inittab and add the following entry to ensure the 
script is called during a level-two boot: 
veritas:2:wait:/etc/rc.veritas.aix


◆	 To shut down, add the following line to /etc/rc.shutdown: 
/etc/rc.veritas.aix stop 

ALPHA Tru64	 /sbin/rc3.d/S77netbackup ->/sbin/init.d/netbackup 
/sbin/rc0.d/K01netbackup ->/sbin/init.d/netbackup 

HP-UX	 /sbin/rc2.d/S777netbackup ->/sbin/init.d/netbackup 
/sbin/rc1.d/K001netbackup ->/sbin/init.d/netbackup 

Red Hat Linux	 /etc/rc.d/rc2.d/S77netbackup ->/etc/rc.d/init.d/netbackup 
/etc/rc.d/rc3.d/S77netbackup ->/etc/rc.d/init.d/netbackup 
/etc/rc.d/rc5.d/S77netbackup ->/etc/rc.d/init.d/netbackup 
/etc/rc.d/rc6.d/K01netbackup ->/etc/rc.d/init.d/netbackup 
/etc/rc.d/rc0.d/K01netbackup ->/etc/rc.d/init.d/netbackup 

SuSe Linux	 /etc/init.d/rc2.d/S77netbackup ->/etc/init.d/netbackup 
/etc/init.d/rc3.d/S77netbackup ->/etc/init.d/netbackup 
/etc/init.d/rc5.d/S77netbackup ->/etc/init.d/netbackup 
/etc/init.d/rc6.d/K01netbackup ->/etc/init.d/netbackup 
/etc/init.d/rc0.d/K01netbackup ->/etc/init.d/netbackup 

Default (all other /etc/rc2.d/S77netbackup ->/etc/init.d/netbackup 
UNIX systems) /etc/rc0.d/K01netbackup ->/etc/init.d/netbackup 

Configuring Storage Devices for the Operating System 
Reliable use of NetBackup depends on the configuration of your storage devices. To 
ensure reliable backups and restores, you must configure devices for your operating 
system according to the instructions provided by the device and operating system 
vendors. This should be completed before you configure NetBackup itself. 

Caution An improperly configured device may lead to backup failures and/or data loss. 
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For clustered environments: 

◆	 Begin configuring all storage devices from the active node. Refer to “Configuring 
NetBackup Server Software” on page 104 for guidelines on configuring storage 
devices to work with NetBackup. 

◆	 For a NetBackup failover server, attach all of the devices to each node in the cluster on 
which NetBackup is installed. Refer to the clustering vendor’s documentation for 
information on how to migrate to another node. 

Note	 To connect a device to the operating system, you should read the chapter 
appropriate for your operating system in the NetBackup Media Manager Device 
Configuration Guide. The guide is available on the NetBackup Documentation CD. 

▼	 To prepare a newly connected storage device 

1.	 Consult your storage device's operating manual or front panel to learn how to set the 
SCSI ID (target). Ensure it is set it to an available SCSI ID. 

2.	 Physically attach your device to a compatible host bus adapter where that SCSI ID is 
available. “Compatible” means that both the device and host bus adapter are of the 
same type (such as single-ended, high voltage differential, low voltage differential, or 
fibre channel). 

3.	 For clustered environments: 

Robotic devices and NetBackup add-on products can be configured to failover 
NetBackup if the robot or add-on product fails. Before you configure this failover, you 
must configure the robots (see “Configuring Storage Devices for the Operating 
System” on page 102) or install and configure the add-on product. Refer to the 
NetBackup High Availability System Administrator’s Guide for instructions on 
configuring devices or add-on products to fail over NetBackup. 

Note Robots must be configured before performing the following steps. 

a.	 Configure NetBackup to fail over if a robotic daemon fails. 

◆	 Configure your robots on each node in the cluster. 

◆	 Run the following script: 

/usr/openv/netbackup/bin/cluster/cluster_config -r


◆	 Add the daemon by choosing a (Add). 

◆	 Specify the name of the robotic daemon you want to monitor. (Multiple robots 
can be added.) 
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b. To remove a robotic daemon from monitoring, do the following: 

◆ Run the following script: 

/usr/openv/netbackup/bin/cluster/cluster_config -r


◆ Remove the daemon by choosing d (Delete). 

◆ Specify the robot daemon type that you would like to remove. 

Configuring NetBackup Server Software 
After the server software and storage devices have been installed, use the Getting Started 
wizard on the NetBackup Administration Console to configure your product. 

For more information on configuring NetBackup, refer to the NetBackup System 
Administration Guide, Volume I. 

Note	 Before configuring NetBackup, you must have the storage devices attached to the 
server and perform all configuration steps specified by the device and operating 
system vendor (including installation of any required device drivers). 

Note For clustered environments: Configure devices on every node in the cluster. 

The NetBackup System Administration Guide, Volume I describes the group of NetBackup 
configuration wizards that appear in the right pane of the NetBackup Administration 
Console when you open it. 

This section steps you through procedures that should allow you to configure a test 
system. 

Note	 If you are configuring NetBackup for the first time, it is best if you click the Getting 
Started icon and use the wizards to guide you through the process. If you have 
already configured NetBackup, and you wish to make a change to particular area, 
you can click any of the remaining options. 

Before Configuring Media Servers 
For NetBackup Enterprise Server. 

The procedures for configuring master or media servers are very similar, and you can 
complete an initial installation of either server first. However, VERITAS recommends that 
you install and configure the master servers before you install and configure media 
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servers. You can then configure media server information (such as storage devices and 
volumes) on the master server to ensure the master server properly administers the media 
server. The following list contains some helpful tips for configuring media servers. 

Note	 For clustered environments: Unless otherwise noted, if a master or media server is 
part of a cluster, its host name should be the virtual name used to configure 
NetBackup. Refer to the NetBackup High Availability System Administrator’s Guide for 
information on configuring an add-on product to fail over. 

If a master server has already been installed, its name appears as the Host server name in 
the left pane of the NetBackup Administration Console of the media server. 

The name of the media server appears as the Host server name in the left window pane of 
the NetBackup Administration Console if any of the following conditions exist: 

◆	 The master server has not been installed. 

◆	 The media server does not have the correct permissions set on the master server. 

◆	 A network problem is blocking the media server from communicating with the 
master server. 

Caution	 If anything is preventing proper communication between the master server and 
the media server, you are still presented with the opportunity to run the 
configuration wizards. Do not run the wizards on the media server until the 
problems have been corrected. If you do, the master server will not recognize 
the information that you enter. VERITAS recommends that you correct the 
problem (such as installing the master server, correcting the permission 
settings, or solving the network problem) and run the configuration wizards 
from the master server. 

Starting the NetBackup Administration Console 
You use the NetBackup Administration Console to configure NetBackup. 

▼	 To start the NetBackup Administration Console on UNIX 

1.	 Log in to the NetBackup server machine as root. 

For clustered environments: Log on to the active node as root. 

If you need to run the user interface on a computer other than the NetBackup server, 
log on to that computer as root for a UNIX system, or as the Administrator for a 
Windows system. 
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2. On UNIX systems, run the following command: 

/usr/openv/netbackup/bin/jnbSA &


The login box appears. 

3.	 Enter the password for root. 

Note For clustered environments: When logging in to the NetBackup Administration 
Console, specify the virtual host name in the Host text box. 

4.	 Click Login. The Login dialog closes and the NetBackup Administration Console 
appears. 

5.	 To begin configuring your product, click Getting Started. The Welcome to NetBackup 
screen appears as the beginning of the configuration wizards. 

Click Next. 

The Device Configuration screen appears and prompts you to begin the Device 
Configuration wizard. 

Note	 There are two wizards available from the initial NetBackup Administration Console 
window that are not part of the Getting Started wizard. They are for help in specific 
processes: creating a snapshot backup and recovering the NetBackup catalog 
should you need to do so for disaster recovery. See the NetBackup System 
Administration Guide, Volume I for information about those wizards. 

Configuring Storage Devices 
Before you can run backups, you must define your storage devices for NetBackup. The 
Device Configuration wizard steps you through this process. However, you must be 
certain that you have correctly configured your storage devices for your UNIX system. 
NetBackup cannot function reliably unless devices are correctly installed and configured. 

Note	 For clustered environments: Begin configuring all storage devices from the active 
node. It is important that you refer to the NetBackup High Availability System 
Administrator’s Guide for step-by-step instructions. 

For a NetBackup failover server, it is usually best to attach all of the devices to every 
node on which NetBackup is installed. 

The Device Configuration wizard takes you through the following processes: 

◆	 Scanning hosts for backup devices 
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◆	 Verifying the devices that were automatically detected 

◆	 Verifying and correcting the drive configuration 

◆	 Updating the device configuration 

Device Configuration Tips 

◆	 You must specify the hosts on which to auto-discover and configure devices. 

◆	 From the Backup Devices screen, confirm that the list of devices displayed is complete 
and accurate. If a known backup device does not appear in this list, you can do the 
following: 

◆	 Verify that the backup device is physically attached to the host. 

◆	 Verify that all installation procedures specified by the device and operating 
system vendor have been performed successfully. 

◆	 Verify that all drives correspond to the proper device. If you need to move a drive, 
select the drive and drag it to the correct location. 

◆	 Updating the device configurations can take a few minutes to complete. 

Defining Storage Units 

◆	 You define storage units from the Configure Storage Units screen. If your system does 
not have a tape device, you can store data on a disk by defining disk storage units. 

◆	 When entering a path for a storage unit, the following rules apply: 

◆	 Use the correct path separators (forward slash (/) for UNIX and backward slash 
(\) for Windows). 

◆	 Use a colon (:) to specify a drive separation on Windows platforms. 

◆	 Use the following characters only: 

◆	 Alphabetic characters (ASCII A-Z, a-z) 

◆	 Numeric characters (0-9) 

◆	 Miscellaneous characters: plus (+), minus (-), underscore (_), or period (.) 

Configuring Volumes 
After you have configured your storage devices, the Getting Started wizard begins the 
Volume Configuration wizard. 
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Note For clustered environments: Configure volumes from the active node. 

Note If you only have disk storage capability, NetBackup skips this wizard. 

The Volume Configuration wizard lets you do the following: 

◆	 Select a device for volume configuration 

◆	 Perform an inventory of the robot 

◆	 Create new volumes 

◆	 Create new volume groups 

Tips for the Inventory of a Standalone Drive 

◆	 The Volume Configuration wizard does not enable you to configure cleaning tapes for 
standalone drives. 

◆	 You can select the number of volumes for your device. 

Tips for the Inventory of a Robot 

◆	 NetBackup conducts an inventory of the robot or device that you selected. Check the 
Results: field after the inventory completes to view what the inventory discovered. 

◆	 After the inventory process of your device completes, the wizard prompts you to 
identify which slots in it contain cleaning media. 

If you have just upgraded NetBackup and have pre-existing barcode rules, the 
barcode reader automatically detects slots designated for cleaning media. If you do 
not designate cleaning slots, NetBackup considers all media (including cleaning 
media) as typical media and tries to overwrite it. 

◆	 If you identified one or more tapes as cleaning tapes in the Identify Cleaning Media 
screen, you see the Robot Inventory (Cleaning Media) screen. It displays the results 
after the software updates the EMM database. 

Configuring the Catalog Backup 
The NetBackup Catalog contains information about your configuration and about the files 
and directories that have been backed up. If a disk fails and your catalog is lost, a backup 
of your catalog makes it easy to restore your backed-up data and resume your backup 
schedule. 

It is imperative that you configure a catalog backup before backing up any other data. 
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Note For clustered environments: Instructions on how to configure a catalog backup are 
provided in the NetBackup High Availability System Administrator’s Guide. 

The Catalog Backup wizard lets you do the following: 

◆	 Create a policy for catalog backup, if one does not exist. 

◆	 Specify destinations for the catalog backup. A backup destination can be either 
removable media or a location on a hard drive. 

◆	 Specify when a backup of the NetBackup Catalog occurs. 

◆	 For NetBackup Enterprise Server environments: You can specify a media server to 
perform the backup. 

Basic Tips for Configuring a Catalog Backup 

◆	 VERITAS recommends that you back up the catalog to tape, if possible. 

◆	 The Catalog Backup wizard allows you to configure either an online, hot catalog 
backup or an offline, cold catalog backup. 

The online, hot catalog backup is new with NetBackup 6.0. It is designed for use in 
very active NetBackup environments that usually have backup activity taking place, 
and for which the catalog itself is large. Online, hot catalog backups can back up the 
catalog while continual client backups are in progress. 

The offline, cold catalog backup works well for less active environments that have 
smaller catalogs. This type of backup cannot span tapes. It also requires that 
NetBackup be quiesced before backups can be run: it cannot back up the catalog while 
any job or catalog operation is running. 

For details on which type of catalog will work best for your environment, refer to the 
chapter on NetBackup catalogs in the NetBackup System Administration Guide, Volume I. 

Tips for Configuring a Catalog Backup if You Have Media Servers 

◆	 You must first select a media server. If you want to back up the catalog to removable 
media, select the media server that has the drive(s) you want to use to write the 
backup to the media. If you want to back up the catalog to a hard drive (which is not 
the recommended method), specify the computer that contains the hard drive. 

◆	 From the NetBackup Catalog Files screen, you verify that the master server's and each 
media server's catalogs are included in the list. Verify that the absolute path names are 
correct and are in the correct format. Follow the instructions on the screen for 
specifying the entire list. 
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The path names of the catalogs on the master server are automatically added during 
installation and generally require no action on your part other than to verify that they 
are listed. However, if you have moved the location of your catalog on your master 
server, the new location must be specified. Path names to the NetBackup catalog on 
the media servers are not automatically added during installation. You must add them 
to the file list. For more information on specifying the path names, see NetBackup 
System Administration Guide, Volume I. 

Creating a Backup Policy 
When you create a backup policy, you specify when a backup takes place, the files you 
want to back up, the clients you want to back up, and other general attributes that define 
how the backup is performed. This wizard lets you define a backup policy for a group of 
one or more clients. 

Note For clustered environments: Configure the policy from the active node. 

The Backup Policy wizard steps you through specifying the following: 

◆	 Policy names and types 

◆	 Clients 

◆	 Files and directories to back up 

◆	 Backup types 

◆	 Backup rotations 

◆	 Starting times of backups 

Types of Backups 

The Backup Policy wizard prompts you to choose the type of backup that you want a 
policy to perform. The following list summarizes your choices: 

◆	 A Full Backup backs up all files specified in the file list. 

◆	 An Incremental Backup backs up all changed files specified in the file list. 

◆	 A Differential Backup is often called a differential incremental backup. It backs up 
files that have changed since the last successful incremental or full backup. All 
files are backed up if no prior backup has been done. 

◆	 A Cumulative Backup is often called a cumulative incremental backup. It backs 
up files that have changed since the last successful full backup. All files are 
backed up if no prior backup has been done. 

◆	 A User Backup is initiated by an end-user to back up specific files. 
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Tips on Creating Backup Policies 

◆	 The list that appears on the Client List screen of the Backup Policy wizard is a list of 
clients that are backed up. You can add, change, or delete clients from this list by 
selecting a name and clicking the appropriate button. 

◆	 You can select how often you want a backup policy to run for full or incremental 
backups. In addition, you can select the retention period for the backups. 

Note	 After you have completed the Backup Policy wizard, you are asked if you want to 
perform an installation verification test. If you choose to do this step, you can click 
the Activity Monitor in the left pane of the NetBackup Administration Console and 
monitor the backup job’s progress. 
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The NetBackup interface can be used by people who are vision impaired and by people 
who have limited dexterity. Accessibility features include the following: 

Note	 Text that appears in the NetBackup interface is accessible through an application 
programmer’s interface (API) to assistive technologies such as voice or assistive 
device input products and to speech output products. 

Using the Keyboard to Navigate in NetBackup 
You can use your keyboard to navigate in the NetBackup interface: 

◆	 Press window navigation keys to move from one window element to another. For 
example, press Tab to move from one pane to another. 

◆	 Perform common actions quickly using accelerator keys. Accelerator keys let you 
initiate actions without first accessing a menu. For example, press Ctrl+n to create a 
new policy. 

◆	 Press mnemonic keys to select items using only the keyboard. Mnemonic keys are 
indicated by an underlined letter. For example, press Alt+h to access the Help menu. 

◆	 You can also use the keyboard to select control options in a dialog. 

Navigating in a NetBackup Tree View 

Use the following keys or key combinations to navigate through the NetBackup Console 
window. 

Keyboard Input Result 

Tab or F6 Moves to the next (right or down) pane in the active NetBackup window. 

Shift+Tab or Moves to the previous (left or up) pane in the active NetBackup window. 
Shift+F6 
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Ctrl+Tab or Moves to the next (right or down) NetBackup window. 
Ctrl+F6 

Ctrl+Shift+Tab or Moves to the previous (left or up) NetBackup window. 
Ctrl+Shift+F6 

Plus Sign (+) on the Expands the highlighted item. 
numeric keypad 

Minus Sign (-) on Collapses the highlighted item. 
the numeric keypad 

Asterisk (*) on the Expands the entire tree below the first item in the active NetBackup 
numeric keypad window. 

Up Arrow Gives focus to the next item up in the pane. 

Down Arrow Gives focus to the next item down in the pane. 

Shift+Up Arrow Selects the next item up in the pane. 

Shift+Down Arrow Selects the next item down in the pane. 

Page Up Moves to the top item visible in a pane. 

Page Down Moves to the bottom item visible in a pane. 

Home Moves to the first item (whether visible or not) in a pane. 

End Moves to the last item (whether visible or not) in a pane. 

Right Arrow Expands the highlighted item. If the highlighted item does not contain 
hidden items, using the Right Arrow has the same effect as using the Down 
Arrow. 

Left Arrow Collapses the highlighted item. If the highlighted item does not contain 
expanded items, using the Left Arrow has the same effect as using the 
Up Arrow. 

Alt+Right Arrow Moves to the next (right or down) option control in the interface. 

Alt+Left Arrow Moves to the previous (left or up) option control in the interface. 

Alt+Spacebar Displays the NetBackup window menu. 
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Using Accelerator Keys 

Accelerator keys let you use NetBackup from the keyboard, rather than using the mouse. 
Accelerator keys are either a single keystroke or two or more keystrokes that can be 
pressed in succession (rather than holding them simultaneously). If available, accelerator 
keys are shown to the right of the menu item they perform. 

For example, to refresh the information in the window, press F5. 

Using Mnemonic Keys 

A mnemonic key is a keyboard equivalent for a mouse click that is used to activate a 
component such as a menu item. To select a menu item, press the Alt key to initiate menu 
pull-down mode, then press a mnemonic key to open a menu, and another mnemonic key 
to select a menu item. 

Mnemonics are case-insensitive. Keys can be pressed either sequentially or 
simultaneously. 

For example, to change the Master Server, press and hold the Alt key then press the f key 
to pull down the File menu, and press the c key to invoke the Change Server menu 
option. 

Using the Keyboard in Dialogs 

To select or choose controls that have an underlined letter in their titles, type 
Alt+underlined_letter at any time when the dialog is active. For example, typing Alt+O is 
the same as clicking the OK button in a dialog. 

To move forward (right or down) from one control to the next, press Tab. To reverse the 
direction (for example, from moving right to moving left), press Tab and Shift. 

To move within a list box, groups of option controls, or groups of page tabs, press the 
arrow key that points the direction you want to move. 

Options that are unavailable appear dimmed and cannot be selected. 

The following conventions are typically used in NetBackup dialogs: 

◆ Command buttons (also known as push buttons) 

Command buttons initiate an immediate action. One command button in each dialog 
carries out the command you have chosen, using the information supplied in the 
dialog. This button is generally labeled OK. Other command buttons let you cancel 
the command or choose from additional options. 

◆ Command buttons containing an ellipsis (...) 
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Command buttons containing an ellipsis (...) open another dialog so you can provide 
more information or confirm an action. Command buttons marked with an arrow 
display a menu. 

◆ Command buttons outlined by a dark border 

A dark border around a button initially indicates the default button. Press Enter or the 
Spacebar at any time to choose the button with a dark border. Press Tab to move the 
keyboard focus to the next control. When you change focus to a command button, it 
temporarily has the dark border. If the focus is not on a control, the dark border 
returns to the default command button in the pane. 

◆ Check boxes 

Check boxes may be selected or cleared to turn an option on or off. Check boxes can 
have two states (checked and unchecked) or three states (checked, unchecked, and 
indeterminate). 

Press Tab to move from one checkbox to another and the Spacebar to change the 
check box to the next state. Typing the mnemonic key for a check box also moves the 
focus to the box and changes its state. 

◆ Option controls (also known as radio buttons) 

Option controls are used to select only one option from a group of options. (Option 
buttons may represent two or three states, as checkboxes do.) Press Tab to move to an 
option button and press the Spacebar to initiate the option. Type the mnemonic key 
for an option control to move the focus to the control and select it. 

◆ Page series 

A series of pages are used to fit many options into a single dialog. Each page contains 
separate groups of controls such as check boxes or option controls. Press Tab to move 
to the name of the page, then use right and left arrows to highlight a different page 
name. Press Return. 

Accessing Online Documentation 
In addition to online help, NetBackup provides copies of related NetBackup manuals in 
Adobe Portable Document Format (PDF) on the NetBackup documentation CD (or as an 
option for downloading if the release is available from the Web). For a complete list of 
NetBackup documents, see the NetBackup Release Notes. 
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